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About this Manual
The TTWin Lite User Guide is a comprehensive document designed to help you work easily and efficiently 
with Turbosoft's TTWin Lite terminal emulation package.

Organization of this Manual

The TTWin Lite User Guide is divided into four parts:

Part One - Basic Concepts
Chapter 1	 Introduction. A brief description of the TTWin Lite product, system requirements and 

installation process.

Chapter 2	 Getting Started. How to connect your machine to a remote host(s) and the basic steps 
required to work with TTWin Lite.

Part Two - Advanced Operation
This section offers more detail on the menus and options that make up the TTWin Lite package. It provides a 
detailed reference guide for these components.

Chapter 3	 File menu. The standard operations: opening and saving session definition files, print and 
print setup utilities.

Chapter 4	 Edit menu. Selecting, copying, clearing and pasting regions.

Chapter 5	 View menu. Operations related to the TTWin Lite screen and interface.

Chapter 6	 Actions menu. All the operations carried out by TTWin Lite: connecting, disconnecting 
captures and terminal control.

Chapter 7	 Help Menu. User help, licensing and related functions.

Part Three - Configuration
This section covers all features available under the Configure menu.

Chapter 8	 Global Preferences. Configuring program wide preferences.

Chapter 9	 Session Preferences. Configuring session related features.

Chapter 10	 Display. Setting up the TTWin Lite window format and scroll history parameters.

Chapter 11	 Fonts. Configuring the display fonts.

Chapter 12	 Mouse. Defining the mouse operation.

Chapter 13	 Printer. Specifying how the printer handles a print job.

Chapter 14	 Miscellaneous Configuration. Other TTWin Lite configuration options.
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Chapter 15	 Working with Macros. Macro format, host initiated macros, examples.

Chapter 16	 Communications. Setting up the type of communications (transport) module.

Chapter 17	 Emulations. Configuring your required emulation.

Chapter 18	 Colors. Creating and changing the color scheme.

Chapter 19	 Keyboard. Remapping the keyboard.

Part Four - Appendices
Several appendices have been included to provide additional information in related areas.

Appendix A	 Glossary

Appendix B	 Customer Support

Appendix C	 Program File Paths

How to use this Manual

The structure of this manual is based on the organization of the TTWin Lite menus. For example, Chapter 3 
File Menu, covers all the options on the File menu, with each option under a main heading. All the menus 
are documented in this manner in Part Two - Advanced Operation, with the exception of the Configure 
menu. 

The Configure menu is described in Part Three - Configuration. Each chapter in Part Three covers one 
section of the Configure menu.

The information provided in Part Two and Part Three is closely linked to the options available under the 
TTWin Lite menu. Chapter order mirrors that of the options available under each menu.

The first-time user of TTWin Lite will probably find it necessary to read the complete section related to the 
operation that they are performing. Users who wish to get started quickly with the basics of TTWin Lite may 
wish to refer to the TTWin Lite QuickStart guide. This PDF document is included with your TTWin Lite 
installation and may be found in the TTWin Lite program group.

This manual assumes familiarity with the version of Windows you are using. The screenshots in this document 
are taken from Windows 7.

If you have any suggestions regarding this guide, please contact Turbosoft with details. Refer to Appendix B for 

contact details.



Conventions

To assist you to read and understand this guide we have used a number of conventions:

Conventions	 TTWin Lite is Turbosoft's terminal emulation product for Windows®.

Windows® refers to Microsoft Windows XP®, Windows Vista®, Windows 7®, Windows Server 
2003® and Windows Server 2008®.

Device refers to any hardware device capable of running Microsoft Windows®

Tile is TTWin Lite’s term for a dialog box.

Lower case bold courier typeface indicates things you need to type, such as a:\setup.

Upper case courier typeface indicates a filename or directory name, such as C:\
TTWINLITE\TTWINLITE.EXE.

All keys are shown in upper case courier typeface and bracketed. For example, the Shift key 
is shown as [shift]; the Escape key is [esC].

Tips, warnings and other important pieces of information are displayed on a grey back-
ground with an icon as shown below.

Hints, tips and other important pieces of information are displayed like this.

A sequence of simultaneous key strokes is indicated with an underscore. For example, 
[ALT_F8] is the sequence generated when the [ALT]key is held down while [F8] is 
pressed.

Bold typeface indicates menus, menu options, tile titles, tile options, tile fields and buttons. 
For example, click on the Colors... button on the Configure IBM 5250 tile then select 
Blink.

Where a step by step procedure is presented each action will be numbered 1, 2, 3 and 
so on.

Where a configuration option is described it's default value is given in brackets. For exam-
ple: Horizontal scroll bar (Auto hide)

An underscore in a bolded word such as, File, refers to the File command, which can also 
be called using the short cut key sequence [alt_F]. This feature is not available on every 
option but a large number of relevant menu locations do offer the short cut key.



11TTWin Lite User Guide : About This Manual

Online Resources

This manual is a dynamic document which is constantly evolving . While we do our best to ensure this manual 
contains the latest and most accurate information you may wish to use our online support center to find the 
latest tips and problem solving documentation. You can access support resources, installation downloads and 
other resources online at:

http://www.ttwin.com/support

Registration is required, valid maintenance holders please contact your Turbosoft representative to ensure you 
have full access to your maintenance entitlements.

http://www.ttwin.com/support


Chapter 1: Introduction

A brief overview of the TTWin Lite product,   

system requirements and installation process.
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What is TTWin Lite?
TTWin Lite is Turbosoft's streamlined Windows terminal emulation solution, providing accurate and robust 
terminal emulation for some of the most popular terminals. It shares much of the technology found in its 
more fully featured sibling TTWin.

Features Highlights

Single Product Terminal Coverage
TTWin Lite includes Terminal Emulations for the more common terminals within one package. No need to 
switch products to get different emulations.

Reduce Keystrokes with Keyboard Macros
Single keystrokes can do complex tasks. TTWin Lite allows you to map macros to keys (including alpha keys in 
various shift states). These macros will do the work for you. Reduced keystrokes means less time to do the job, 
and a more accurate result.

Scroll History
TTWin Lite increases productivity in many ways. Its Scroll History allows you to review information that has 
rolled off the screen, and use cut and paste to move this into and out of other applications such as spreadsheets 
and word processors.

Multiple Sessions
TTWin Lite allows you to run as many sessions as you need to the one host system or to many.  What's more 
each session can be configured independently to your requirements.

System Requirements

TTWin Lite supports the following operating systems

Windows XP
Windows Vista 
Windows 7
Windows Server 2003 
Windows Server 2008

TTWin Lite is compatible with Windows 95/98/NT and Windows 2000, however Turbosoft no longer actively 
supports these systems and offers no guarantees as to functionality.

Hardware Requirements

Approximately 16MB of free disk space.
A network connection or serial port for COM type connections.

>
>
>
>
>

>
>



Installation

The TTWin Lite installation package is available as an Internet download from http://www.ttwin.com. As of 
version 4.5 both 32 bit and 64 bit versions are available.

On your Windows PC, run the downloaded installation file. 

The Software License Agreement is displayed. Please carefully read the License Agreement before installing 
the software. Installing the software establishes your acceptance of this agreement.

Next you will be asked to enter a User and Company Name and to select whether other users are permit-
ted to run the application.

Select the locations you would like TTWin Lite application to be installed. Refer to Appendix C for default 
program file path.

Select Install to begin the installation. TTWin Lite will be installed to the location specified.

Select Finish to complete the installation. You are now ready to start TTWin Lite.

Evaluation Mode

An unlicensed version of TTWin Lite defaults to an evaluation mode. In evaluation mode TTWin Lite is 
fully functional but is restricted to 40 connection attempts, each of which is limited to a maximum of four 
hours each. If you find this limitation inadequate for your evaluation purposes please contact your reseller or 
Turbosoft directly. 

When initially launched TTWin Lite attempts to connect to a host automatically using its default configuration. 
If you have not yet applied a license to TTWin Lite you will see the Evaluation Notice tile shown (Figure 
1) each time a connection attempt is made. If you do not want to connect at this point click Cancel. This will 
allow you the opportunity to modify or load another configuration or to apply a license. 

TTWin Lite can be easily converted into a licensed, unrestricted version without the need for re-installation 
simply by inputting appropriate license information. 

Figure 1. TTWin Lite Evaluation Notice Tile

1�

2�
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http://www.ttwin.com
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Licensing TTWin Lite

When you purchase TTWin Lite a license certificate file (.TCF) will be issued. Enabling your copy of TTWin 
Lite is a two step process involving firstly the import of that certificate file into the program, and secondly, the 
activation of that certificate by Turbosoft.

To import the license certificate follow these steps:

Start the program and select Help > About TTWin4 Lite from the main menu.

Select the License Tab as shown in Figure 2

Click the Import certificate button and select the certificate file from your local hard drive.

Once imported, you will see a message box stating “The license has been updated. This license needs to be activated”. 
You have 7 days to complete this activation process.

Figure 2. TTWin Lite License Tab

1�

2�

3�



Activating the license
License activation stamps your license certificate with a unique identifier and completes the licensing process.

There are two activation methods, online (the default) or manual activation.

Online Activation 
For this option to work TTWin Lite needs to be able to connect to the Internet.

When prompted to activate TTWin Lite select the Activate online option then click the Activate button.

TTWin Lite will then connect to the Turbosoft Activation Server and automatically import a new certificate 
unique to the PC you are installing on. Your software is now activated.

If you receive a connection error please wait a moment and try again. If you continue to receive this message 
check if firewall or proxy server settings are preventing TTWin Lite accessing the Activation servers. In this 
situation we recommend manual activation.

Manual Activation
If TTWin Lite is unable to connect to the Internet from the PC it is installed on you may activate your soft-
ware using the manual activation process:

Select the Save the Request to a File option and click the Activate button.

Save the resulting .ACT file

Copy this file to a PC that has Internet access.

Open a browser to http://mercury.ttwin.com/request

Fill out the activation form selecting the .ACT from your local PC.

Optionally, enter an email address where you would like the new activated certificate to be sent.

Select the Retrieve Certificate File button.

You will then be presented with a link to download a new certificate file and, if you chose to enter an email 
address, the file will also be sent to you. Transfer this file to the PC containing your TTWin Lite installation 
and do the following:

Start TTWin Lite and select Help > About TTWin4 Lite and click on the License tab. 

Click the Import certificate button and load your new certificate file.

Restart TTWin Lite. 

1�

2�
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http://mercury.ttwin.com/reques


17TTWin Lite User Guide : Chapter 1 - Introduction

Uninstalling TTWin Lite 

To uninstall TTWin Lite you should follow the standard software uninstallation process for your operating sys-
tem. Typically this operation is performed by selecting start menu > control panel > uninstall software.

TTWin Lite retains any extra setting files you may have copied or created whilst using the software including 
the following file types:

Session files (.twc)
Color files (.clr)
Keyboard mapping files (.key)
History Files (.thf)
License Files (.tcf)

Refer to Appendix C for information on program file paths and the location of these files.

>
>
>
>
>



Chapter 2: Getting Started

How to connect your machine to a remote host 

and the basic steps required for getting started 

with TTWin Lite.
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Getting Started
TTWin Lite uses TTWin Configuration (.twc) files to specify users preferences and settings. When you first 
launch TTWin Lite the program will make use of a default predefined configuration file default.twc. This 
.twc file specifies a VT420 emulation over telnet and is set to autoconnect. This means you will initially see a 
tile asking that you to specify a remote host when the software is first launched.

Additionally, if not licensed TTWin Lite will default to an evaluation mode and an additional tile will be dis-
played notifying you of the number of remaining connection attempts available under the evaluation license. 
For more information on the limitations of the evaluation license please see Chapter 1.

Figure 4. Evaluation Notice Tile.

At this point you may wish to click Cancel to modify the configuration or license your TTWin Lite software. 

Quick Configuration

Please refer to Part Three of this document for more in depth detail on configur-
ing TTWin Lite.

Before initiating a connection there are a few pieces of information you need in order to complete a successful 
connection to a host system. 

Firstly, you need to know what sort of terminal you wish to emulate. TTWin Lite supports numerous emula-
tions and you will need to know which one to choose in order to successfully interact with your host applica-
tions. 

Next, you need to know how you are going to communicate with the host system.  You will need to know 
what method of communications your host is expecting, as well as your host address and any settings that you 
require. 



This information, along with any particular settings that you require, should be available from your System 
Administrator. 

Access to different configuration options is available via the Config menu. 

Figure 4. Config Menu 

To select and modify the emulation settings of TTWin Lite open Config > Emulation from the main menu. 
This will display a tile similar to that shown in Figure 5 is displayed.  By default TTWin Lite is configured to 
use a VT420 emulation. 

Figure 5. Configure Tile (DEC VT420) 

Figure 5 consists of a tree list of the configurable emulation options together with an edit box through which 
the currently highlighted item may be modified.
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To switch to a different emulation select the top item (the name of the emulation module) as shown in Figure 
5.  A Select Another… button should display in the edit box. Clicking on the Select Another… button will 
display the emulation selection tile from which a different emulation may be selected.

Upon selecting a different emulation TTWin Lite will load this emulation and return to the Configuration tile 
with the configurable options for the new emulation. 

The communications module may be modified in a similar manner to the emulation by selecting Config > 
Comms from the main menu. 

Figure 6. The configure comms tile (telnet).

Saving Your Settings

Once you have selected your emulation and communication settings, be sure to save the configuration file 
for future use. From the menu, choose File > Save to overwrite the current configuration (this will be the 
default.twc file initially) or File > Save As to retain your settings in a new .twc file.

If you select Save As, you will be prompted for a file name, and once this has been entered you can save 
the configuration file. By default the configuration file will be given a .twc file extension and stored in the 
Turbosoft\TTWin Lite directory in your user profile (see Appendix C for more detail on program file 
paths).



Specifying a Predefined Session at Startup

To load TTWin Lite with a predefined configuration, create a shortcut to TTWin Lite and add a command line 
option pointing to your chosen TWC file. For example.

Right click on your desktop and select New > create shortcut 

Locate TTWin Lite, typically the output will be similar to this example: "C:\Program Files\
Turbosoft\TTWin Lite\ttw4lite.exe"

Add the name of your twc after the command line. If your twc file is NOT located in the default user 
directory (see Appendix C) you will need to provide an absolute path. Your shortcut line will be something 
like this "C:\Program Files\Turbosoft\TTWin Lite\ttw4lite.exe" my5250.twc

Other command line parameters

TTWin lite supports several command line parameters:

-i ini_file   	 specify the ini file
-f			   start in full-screen mode
session_file    	 optional twc file 

Connecting

To initiate a connection, choose the Action > Connect menu function. 

Figure 7. Initiate a connection. 

If you are running an evaluation version of TTWin Lite you will, at this point, see a tile informing you of the 
limitations and remaining connections associated with this license. To continue with the connection accept the 
notice by clicking OK. TTWin Lite will now attempt to connect to the host or, where applicable, prompt you 
for more details before connecting.

1�

2�

3�
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Disconnecting

A TTWin Lite session may be disconnected from the host computer in a number of different ways, usually as a 
result of the user logging out from the host computer. 

To manually disconnect, you may select the Action > Disconnect function from the TTWin Lite menu as 
shown in Figure 8. 

Users of an evaluation license will be automatically disconnected should their connection reach the 4 hour 
limitation. Prior to reaching that time, TTWin Lite will display warning messages informing you of the 
approaching time limit.

Figure 8. Disconnecting. 



Chapter 3: File Menu

The standard operations: opening and saving 

session definition files, print and print setup.
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File Menu
The file menu contains commands associated with loading and saving configuration files and printer opera-
tions.

Figure 9. TTWin Lite File Menu

Open…  

Selecting the Open menu option will activate the Load a TTWin configuration tile. From this tile you can 
choose one of the available predefined sessions to be loaded. A predefined session is a file containing a com-
plete set of TTWin Lite configuration settings created with the Save As... option.

File name
Enter the name of the predefined session file that you want to use. The default extension is .TWC, TTWin 
Lite's custom format for session configuration data. Available predefined session files, from the current direc-
tory, are displayed in the Files: box.

Look in
This box displays the current directory from which the file will be loaded. This may be changed through the 
Look in: box down arrow, shows a list of drives and directories. By selecting entries from here, the drive and 
directory from which the predefined session will be loaded is changed.

Files
This box displays the files that match the file name entered in the File name: box. To load the required prede-
fined session from this list either enter the file name in-full in the File name: field then select OK or double 
click on the filename in the list.

After opening a predefined session (e.g. SAMPLE1.TWC) all session parameters are reprogrammed to the set-
tings defined in the newly loaded session.



Save (default.twc)

Clicking the mouse on the Save option saves all the configuration settings of the current predefined session to 
the .TWC file in round brackets next to the save command.

Save As… 

Selecting the Save As... option will activate the Save a TTWin configuration tile. Use this option to save the 
current session settings to a new preconfigured session file.

File name
Enter the name of the file to which you wish to have all TTWin Lite configurable settings saved into.

Save in
This box displays the directory to which the file will be saved. This may be changed through the Save in: box 
down arrow, shows a list of drives and directories. By selecting entries from here, the drive and directory to 
which the predefined session will be saved is changed.

When the required file name has been specified, click the Save button.

Print… 

Selecting the Print... menu option activates the Print Screen tile. The Current Printer is displayed at the 
top of the Print Screen tile.

Text to print
Entire screen (default): The entire contents of the current screen are sent to the defined printer.

Selected text only: This option is only available when a region of the screen has been selected. 

You can select text by dragging the mouse across a region. The selected area will be visible by a shaded back-
ground.

Close print run

Clicking the mouse button over the Close print run option TTWin Lite closes any active print run.

This is used when 'print through' is used in an emulation, the Close print run command, sends any outstand-
ing, buffered, data to your printer and then closes down the print job. 

Unless Configure > General > Printer > Keep print job open (on) is used, this option is grayed out. 
See Chapter 13 for more detail on this setting.

Print setup… 

Selecting the Print Setup... command activates the Printer Setup tile. This directly interfaces into the 
Windows print setup, and allows you to specify and configure your preferred printer.
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Printer
The printer required for your particular print job can be selected and configured.

Name
To select a specific printer, click the mouse button on the down arrow to the right of the box below the 
Specific Printer option. This will activate a list of your installed Windows printers from which the required 
printer may be selected by highlighting it.

Paper Size 
Clicking the mouse on the down arrow to the right of the box next to this option activates the list of available 
sizes. From this list select the size you want to use by highlighting it. 

Source
Clicking the mouse on the down arrow to the right of the box next to this option activates the list of available 
paper sources. From this list select the paper source required by highlighting it.

Orientation
This option controls the direction of the print job. Available options are Portrait (tall) and Landscape (wide).

Figure 10. Print Setup Tile

Exit 

Selecting the Exit option closes down TTWin Lite.

Once you have completed your work on the remote host, it is good practice to 
log out FIRST or close down the connection to the remote host before exiting the 
TTWin Lite program.



Chapter 4: Edit Menu

Selecting, copying, clearing & pasting regions.



29TTWin Lite User Guide : Chapter 4 - Edit Menu

Edit menu
The edit menu covers commands dealing with the manipulation of terminal content.

Figure 11. Edit Menu

Copy

The Copy command will copy a selected region to the Windows clipboard for later use by the Paste com-
mand. The region to be copied is selected by dragging the mouse while either the left or right mouse button is 
held down.

Copy to file…

Selecting the Copy to file... command activates the Copy selected text to a file tile.

File name
Enter the name of the file to which you wish to have the selected text saved into, the default is SCREEN.TXT. 

Save in
This box displays the directory to which the file will be saved. This may be changed through the Save in: box 
down arrow, shows a list of drives and directories. By selecting entries from here, the drive and directory to 
which the file will be saved is changed.

When the required file name has been specified, click the Save button.

Paste

The Paste command will insert, at the current position of the cursor, the contents of the Windows clipboard.



Select display

The Select display command will select the full contents of the currently displayed TTWin Lite session win-
dow.

Select all

The Select all command will select the contents of the current TTWin Lite session window and the entire 
scroll history buffer.

Clear display

To clear the contents of the current display region, use the Clear display command. After the display area is 
cleared the cursor is positioned at the top left corner of the screen.

Clear all

To clear the entire contents of the current scroll history buffer along with the current display region, use the 
Clear all command.

After the display is cleared the cursor is positioned at the top left corner of the screen.

Clear history

To clear the contents of the scroll history buffer only, use the Clear history command.
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Chapter 5: View Menu

Operations related to the TTWin Lite screen and 

interface.
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View Menu
The view menu controls aspects of the program appearance.

Figure 12. View Menu

Toolbar (on): 

Controls the display of the program Toolbar. Uncheck if you do not wish to display the Toolbar

Status Bar (on): 

Controls the display of the program Status bar. Uncheck if you do not wish to display the Status Bar.

Figure 13. Status bar and toolbar



Full screen: 

Select Full screen to enable Full screen mode, this will expand TTWin Lite's terminal display area to entirely 
fill you device screen. Once you have selected Full Screen this becomes the default mode. 

To deselect full screen mode right click your mouse on the screen to display a pop up menu and uncheck the 
Full screen option. In the event that you have overridden the default right click action (see chapter 12) press 
[ALT_V] to access the view menu.
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Chapter 6: Actions Menu

All the operations carried out by TTWin Lite: 

connecting, disconnecting, captures and termi-

nal control.
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Actions Menu
The Actions menu controls terminal activity such as connecting to and disconnecting from a host system.

Figure 14. Actions Menu

Connect

Selecting the Connect menu item will initiate an attempt to connect to a host (either a tile requesting host 
details will appear or the host detail specified in you session configuration is used). If a connection is successful 
the Connect menu item toggles to read Disconnect.

Capture…

Selecting the Capture... menu item activates the Capture tile. Capturing is the process where data received 
from your remote host is sent to a nominated file or to the Windows clipboard. 

Capture mode
Diagnostic (default): The entire data stream is written to the specified file along with configuration infor-
mation. This is for use by Turbosoft support. 
Visual: Only ASCII printable characters are written to the specified capture file or the Windows clipboard.
Raw: The entire data stream from the host is written to the specified capture file or the Windows clipboard.

Capture to File (default)
Specify the name of the file to which TTWin will capture PC-host connectivity data, the default filename is 
TTWIN.CAP. When Capture to a file is selected a file name must be entered in the Filename field. 

>

>
>



Clipboard
The captured data is written directly to your Windows clipboard.

The capture file is buffered, and is not immediately written to disk. Attempting to 
capture a problem which causes your PC to hang or reboot may not be successful.

File Mode Append
Appends the capture details to the end of the file named in the Filename box. If the file name given does not 
exist, a warning message will be displayed, and a new capture file will be created. 

Compressed (default)
Creates a compressed file, effectively a zip file, insuring the integrity of the data.

Upon selecting OK to start the capture the Capture... menu option toggles to Stop Capture... To close the 
capture file select the Stop Capture... option.

Figure 15. The Capture tile
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Break

Selecting Break sends a break signal to the remote host. A Break is a time delay signal transmitted to the 
remote host. The break signal is used to interrupt the remote computer, overriding any other task it may be 
executing.

The Break duration can be varied by opening Config > Comms and selecting Serial Comms (see chapter 16 
for more detail). The default setting for a Break signal is 100 milliseconds.

Unlock flow control

Selecting Unlock flow control unlocks flow control between your PC and the remote host. Occasionally 
your PC and the remote host can lose synchronization of their flow control status. This stops the screen from 
updating. Unlock flow control overcomes this problem.

Flow control problem can be the result of incorrect settings of the XON/XOFF parameters, if unlocking does 
not resolve the problem you should examine these settings. Refer to the section of Chapter 16 dealing with 
serial communications configuration for more detail.

Reset terminal

Selecting Reset terminal resets the terminal. This is to clear garbage characters that appear on screen, due 
to line noise etc. The Reset terminal command clears the screen, puts the cursor in the home position and 
resets the emulation parameters to their default settings.



Chapter 7: Help Menu

Product version, licensing and related functions.
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Help Menu
The help menu provides access to product version and licensing information.

About TTWin 4 Lite

Selecting this menu option bring up the program about tile. This provides access to detailed information on 
the program version and the licensing options.

About:
The About tab provides information on the overall program version and a link to the Turbosoft Website. This 
version information should be quoted in dealings with Turbosoft Support staff.

Figure 16. TTWin Lite About Tile.

Version:
The Version tab provides more detailed product version information including version information on pro-
gram components. This version information should be quoted in dealings with Turbosoft Support staff

Figure 17. TTWin Lite Version information.



License:
The License tab displays information about the status of TTWin Lite's current license. By default an unli-
censed version of TTWin Lite will be in evaluation mode as shown in figure 18. 

A licensed version of TTWin Lite will display the licensee name, a serial number and a status entry of 'Valid'. 

Figure 18. TTWin Lite License information, in evaluation mode.

For information on how to license TTWin Lite please refer to Chapter 1.
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Chapter 8: Global Preferences

Configuring program wide features.
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Global Preferences
Global preferences are accessible by selecting Config > General from the main menu, then selecting the 
Global Preferences heading.

Figure 19. Global preferences configuration.

Code page (950): 

The code page that describes the character set for your particular language.

File Preferences:

Backup configuration files (off)
If selected, then, whenever changes are made to any operation files, such as .TWC files, TTWin Lite creates a 
backup. Backup files have a .BAK extension.



Chapter 9: Session Preferences

Configuring Session based preferences.
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Session Preferences
Session preferences control connect and disconnect options along with other session dependent options such 
as Title and Status Bar text.

To access the session options configuration select Config > General from the main menu and select session 
preferences for the list on the config tile.

Title and Status Bar Text 

The TTWin Lite Title Bar and Status Bar texts are configurable and appear as shown in Figure 20. 

Figure 20. Session preferences configuration.

TTWin Lite has a number of inbuilt variables for use in the Title and Status Bar text.

Code	 Description

%T	 Inserts the text string TTWin into the title.

%S	 Inserts the name of the session file into the title.

%E	 Inserts the current Emulation module into the title. This variable is updated in the title if 
the Emulation module for that session is changed.

%C	 Inserts the current Comms module into the title. This variable is updated in the title if the 
Comms module for that session is changed.

%D	 Inserts the current date in the title.



%O	 Inserts the current connection status into the title bar. If the session is connected to a 
host this will read Connected. If the session is disconnected from the host it will read Not 
Connected. This variable is updated in the title bar whenever the connection status changes.

%P	 Inserts the current printer status into the title bar.

%N	 Inserts an integer representing the instance of TTWin Lite when the session was started. 
The number is 1 if no previous sessions are running.

%H	 Inserts the current state of the visible TTWin Lite window into the title bar. If history is 
being viewed then ‘Viewing history’ will be displayed.

%M	 Inserts the current state of TTWin Lite macro language into the title bar. If a TTWin Lite 
macro is currently executing then ‘Macro running’ will be displayed.

%B	 Inserts the current state of the pasting mechanism into the title bar. If TTWin Lite is pasting 
from the clipboard to the emulation window, then ‘Pasting’ will be displayed.

%U	 Inserts the current state of the emulation into the title bar. If TTWin Lite enters a pause 
state either by user input or host action the ‘paused’ will be displayed.

%A	 Inserts the current state of the TTWin Lite capture mechanism. If TTWin Lite is currently 
capturing data then ‘capturing’ will be displayed.

%L	 Inserts the current date of TTWin Lite text selection mechanism into the title bar. If the 
mouse is being used to select text within the TTWin Lite emulation window, then ‘Region 
Selected’ will be displayed.

%,	 Inserts a comma between the currently displayed option and the previously displayed 
option. The comma is removed when the currently displayed option ceases displaying.

%Z	 Inserts the host name into the title bar.

%%	 Inserts the text character % into the title. This is required as a separate entry as the % sym-
bol is used by TTWin Lite to represent title variables. This variable adds a "%%" to ensure it 
is read as a text character.

By default the Title bar settings are %T Session %N - %S - %E %O via %C

This will resolve to something like: TTWin Lite Session 1 – default.twc – DEC VT420 Not connected via Telnet

The default Status bar text settings are %H %P %M %B %U %A %L

This will output status based information such as 'Viewing history' or 'Printing' in response to user activity.
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Action on disconnect (Notify)

When a session is disconnected from the remote host (logout, [^D], exit, quit etc) TTWin Lite can do a 
number of things:- 

No action 
The connection is quietly closed. The Top Status Bar displays Disconnected. On disconnection the user stays 
in TTWin Lite.  

Notify 
A tile will appear stating that the connection has been closed. The Top Status Bar toggles to Disconnected. 
The user stays in TTWin Lite.  

Reconnect 
Causes TTWin Lite to reconnect to the host.

Exit 
Closes down and exits TTWin Lite without any notification.  

Auto connect on startup (on)

Deselect this if you do not want TTWin Lite to automatically connect to the host when launched.

Startup string () 

As soon as TTWin Lite is loaded, prior to attempting to initiate a connection to a nominated host, the Startup 
string, a macro, is executed.

Connect string ()

If the Auto connect on startup option is selected AND a connection to the remote host succeeds, the 
Connect string is then executed. E.g. the string \p010username\r\p010password\r equates to \
p010: pause 1 second, username\r: send the username and enter/return, \p010: pause 1 second, pass-
word\r: send the password and enter/return.

How to Automate Login

You can use the connect string session preference and a macro to automate the login process. If combined with 
an Auto connect on startup setting of on, TTWin Lite will automatically connect and login to your host 
when launched. To automate the login process complete the following steps:

From the menu select Config > General then select the Session Preferences > Connect String 
option.

In the Connect string enter the login details follow by the emulation keys in braces, a pause at the begin-
ning will give the host time to respond. For example:

\p010UserName{Return}\p010Password{Return}

1�

2�



The above string will pause for 1 second send the username, send the Return key, then pause for another sec-
ond, send the Password, then send a second Return key. For a list of macro options refer to Chapter 15.

The name of the {Return} key may change depending on the emulation being 
used.

Select File > Save to retain these settings. Refer to Chapter 2 for information on saving session settings.

Reset emulation on connect (off) 

On establishing a host connection TTWin Lite resets the terminal emulation.

Reset emulation on disconnect (off) 

On disconnecting from a host system TTWin Lite resets the terminal emulation.

1�
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Chapter 10 : Display

Configuring the TTWin Lite window format and 

scroll history parameters.
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Display
Display options can be configured to change the appearance of TTWin Lite's terminal display characteristics.

To access the display configuration options select Config > General from the main menu and open the 
Display heading as shown in Figure 21.

Figure 21. TTWin Lite display configuration.

Options:

Enable blink (on):
This toggles the blink attribute for text. 

Enable invisible (on): 
This attribute enables or disables the visibility attribute for text.  

Display busy refresh (ms) (100)
The time in milliseconds between screen refreshes.

Draw underline characters (off)
Use the graphical underline character rather than underscore characters.

Hide cursor when not in focus (off)
The cursor is hidden when TTWin Lite is not the active application.

Bell Sound (Windows Default): 
Disabled: No bell sound will be used.
Windows Default: Uses the default Windows sound
Windows OK:
Windows Question:

>
>
>
>



Windows Hand:
Windows Exclamation:
Windows Asterisk:
Sound File: Use the Bell sound file defined in the Bell Sound File option defined below.

Bell Sound File () 
Selecting Browse… will open the File Browse tile, use this to navigate to the location of the sound file you 
wish to use.  The sound file must be in .WAV format.

Lock status line (off): 

Cursor

Cursor visible (on)
Deselect this option if you have an application where the cursor must be invisible.

Cursor blink (on)
Sometimes locating your cursor on the screen can be a daunting task. Setting the cursor to blink makes finding 
it quite easy.

Cursor shape (Full block)
The actual shape of the cursor can be set to suit particular applications running on your remote system.  The 
cursor styles available are: 

Small Block: A half height block filling the lower half of a character.
Full Block: A full character solid block. 
Horizontal Line: An underscore character. 
Vertical Line: A centred horizontal full character height line.

Ruler

Style (Off)
The styles of ruler to be used

Off: No ruler will be displayed.
Vertical line: A vertical ruler will be displayed.
Horizontal line: A horizontal ruler will be displayed.
Cross: A cross hair ruler will be displayed.

Color (RGB=000000)
Choose the ruler color. Clicking the edit button brings up a color selection tile.

Line width (1)
Select the width of rule in pixels.

>
>
>
>

>
>
>
>

>
>
>
>
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Scroll

Jump scroll (Unlimited)
By clicking on the drop down menu on the Jump scroll field, the available scroll rates are displayed. Setting 
this to 4 lines, for example, will cause the display to be updated whenever 4 lines have been scrolled.

Vertical scroll bar (Auto hide)
Always off: The vertical scroll bar is disabled.
Always on: The vertical scroll bar is enabled.
Auto hide: The vertical scroll is only displayed if sufficient history is available.

Horizontal scroll bar (Auto hide):
Always off: The horizontal scroll bar is disabled.
Always on: The horizontal scroll bar is enabled.
Auto hide: The horizontal scroll is only displayed if emulation window is smaller than the default emula-
tion width.

Follow cursor (Follow) 
Controls how the data is displayed when the TTWin Lite window is smaller than the emulation work area. 

Follow cursor is only used if auto scaling is disabled.

Off: The display does not follow the cursor.
Follow: The display scrolls with the cursor, the cursor is always in the visible work area.
Centred: The cursor is centred within the visible work area.

Grid

Places a grid over the emulation screen with the entered Horizontal and Vertical Grid spacing.

Active (off)no grid is displayed

Color (Major lines) (RGB=000000): select color for major grid lines.

Color (Minor lines) (RGB=000000): select color for minor grid lines.

Line width (major) (1): width of major grid lines in pixels.

Line width (minor) (1): width of minor grid lines in pixels.

Vertical line spacing (major) (5): the number of rows between major vertical lines.

Vertical line spacing (minor) (0): the number of rows between minor vertical lines.

Horizontal line spacing (major) (10): number of columns between major horizontal lines.

Horizontal line spacing (minor) (5): number of columns between major horizontal lines.

>
>
>

>
>
>

>
>
>



History 

The scroll History facility enables information that has scrolled off the top of the screen to be viewed. 

History enabled (on): Deselect to disable the scroll history feature.

Copy to history on a screen clear (on): copies the content of the screen to history once a clear screen has 
been sent.

Keep colors and attributes (off): When deselected, information once scrolled off the screen is only saved as 
ASCII text. When selected, all screen colors or attributes are retained through the scroll history.

Save history to a file (off): If you wish to save the history to a file set the save history option.

History file name (history.thf): To change this name enter the new name into the File name field or browse 
to select another file name. The history file has a .THF extension.

Max. history size (128k): The size can be modified by simply clicking on the Max. history size and then 
selecting the appropriate value that you require. Available values are: 8k, 16k 32k, 64k, 128k, 256k, 512k and 
1MB.



57TTWin Lite User Guide : Chapter 10 - Display



Chapter 11: Fonts

Selecting and configuring display fonts.
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Fonts
To configure TTWin Lite's font options select Config > General from the main menu and open the Fonts 
heading as shown in Figure 22.

Figure 22. TTWin Lite font configuration.

Options for font configuration are as follows:

Auto scale (on)

Whenever the TTWin Lite window is resized by the user, the font is scaled to best fit the new active window 
region.

Smooth scaling (on)

Scales the font to make use of the full emulation window.

Standard text font (Lucinda Console)

This will activate the TTWin Lite Font Selection tile. From the fonts listed select the one desired and click 
OK. For best operation it is highly recommended that you select a monospace font such as Lucida Console or 
Courier.

Unicode/DBCS font ()

This will activate the TTWin Lite Font Selection tile. From the fonts listed select the one desired and click 
OK.



CharHeight (20)

Character height in pixels if Auto Scale is off.

CharWidth (10)

Character width in pixels if Auto Scale is off.
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Chapter 12: Mouse 

Defining the mouse operation.
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Mouse Configuration
Mouse configuration controls the way in which the mouse is used to select text on the display.  Mouse actions 
can be assigned to single and double clicks for both the left and right mouse buttons. 

The middle mouse button and scroll wheel are unused in TTWin Lite.

Assigning Mouse Actions

Mouse configuration options can be found under general preferences options. Select Config > General to 
open the configuration tile and open the Mouse options. 

Figure 23. TTWin Lite mouse configuration.

Left Mouse Button (Continuous marking)

The following mouse actions are available for left single click actions.

Continuous Marking 
This highlights a continuous line of text from the display area. The selection starts at the row and column loca-
tion corresponding to the mouse pointer location when the command was issued and includes all partial and 
complete lines of text up to the location at which the mouse button is released.

Rectangular Marking
Allows you to select a rectangular screen region.



Display dragging 
By holding down the mouse button and dragging the pointer you can scroll the TTWin Lite terminal display.

Unassigned
Do not associated an action with a mouse click.  

By default, the program right click action brings up a menu. Setting any action 
other than Unassigned will override this action. 

Right mouse button (Unassigned)

The following mouse actions are available for right single click actions.

Continuous Marking 
This highlights a continuous line of text from the display area. The selection starts at the row and column loca-
tion corresponding to the mouse pointer location when the command was issued and includes all partial and 
complete lines of text up to the location at which the mouse button is released.

Rectangular Marking
Allows you to select a rectangular screen region.

Display dragging 
By holding down the mouse button and dragging the pointer you can scroll the TTWin Lite terminal display.

Unassigned
Do not associated an action with a mouse click. 

Figure 24. Continuous Marking.
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Left double click (Unassigned)

The following mouse actions are available for left double click actions:

Select word
TTWin Lite will highlight the word directly under the mouse pointer.

Send word
TTWin Lite will copy and paste the word directly under the mouse pointer into the terminal.

Unassigned (default)
Do not associated an action with a mouse click.

Right double click (Unassigned)

The following mouse actions are available for right double click actions:

Select word
TTWin Lite will highlight the word directly under the mouse pointer.

Send word
TTWin Lite will copy and paste the word directly under the mouse pointer into the terminal.

Unassigned (default)
Do not associated an action with a mouse click. The program default action is to display a pop up menu on a 
right click in the display area (see Figure 25). Assigning an action here will override that default behavior.

Figure 25. Right click default menu.



Chapter 13: Printer

Specifying how the printer handles a print job.
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Printer configuration
In order to simplify printing operations, TTWinCE's printer configuration provides the facility to send print 
control sequences over and above that which is offered in Windows.

To access the printer configuration select Config > General from the main menu and click on the printer 
heading on the Configure tile.

Figure 26. TTWinCE printer configuration.

The printer options are as follows.

Suppress printing (off)

Select this option should wish to disable printing.

Printer (Default printer)

Selecting Edit... opens the Printer Setup tile, allowing you to select from the printers you have configured on 
your workstation. Selecting Default… will use your windows default printer as the TTWinCE default printer.

Default Printer Overrides

PrnDfltOrientation (default): 

Default: Uses the orientation as configured for that printer by default.
Portrait: Overrides the printer default orientation to portrait.
Landscape: Overrides the printer default orientation to landscape.

>
>
>



Print in raw data mode (off): 

Printing raw data involves the print job data stream being sent directly to your selected printer with no TTWin 
intervention. When printing in raw data mode, the Process LFs, Process CRs and Wrap lines longer than the 
page width options will have no effect.

Wrap lines longer than the page width (off)

Lines longer than the width of the print page are not wrapped onto a new line.

Bottom margin (4)

The number of lines you wish to have for the page bottom margin.

Keep print job open (off)

There may be times when you need to close the print job manually.  This can be done through TTWinCE. If 
this option is selected, the Close print run... becomes available option on the File menu to close the print 
job. 

String to print at start of job ()

The string entered here is sent to the printer prior to the print job being sent. This is typically used to initialize 
the printer. 

String to print at end of job ()

This string is sent to the printer on completion of the print job.

Printer font (Courier New)

Selecting Edit... opens the Font tile, allowing you to select from the fonts you have installed on your worksta-
tion.

Process CRs (Normal)

This parameter determines how TTWinCE handles carriage returns sent by the host.

Normal: Carriage returns are processed normally.
Strip them: Carriage returns are removed.
To LFs: Carriage returns are replaced with linefeeds.
To CR-LFs: On receipt of a carriage return, a linefeed is performed as well as a carriage return.

>
>
>
>
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Process LFs (Normal)

This parameter determines how TTWin handles linefeeds sent by the host.

Normal: Linefeeds are processed normally.
Strip them: Linefeeds are removed.
To CRs: Linefeeds are converted to Carriage returns.
To CR-LFs: On receipt of a linefeed, a carriage return is performed as well as a linefeed.

>
>
>
>



Chapter 14: Misc. Configuration

Other TTWin Lite configuration options.
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Miscellaneous Configuration
To access these configuration options select Config > General from the main menu and scroll down to the 
required section on the configuration tile.

Figure 27. TTWin Lite configuration.

Clipboard

Shortcut key for clipboard copy (None):
None: No shortcut key is defined.
Ctrl +C: The sequence Ctrl C is to be used as the copy shortcut.
Alt + C: The sequence Alt C is to be used as the copy shortcut.

Shortcut key for clipboard paste (None):
None: No shortcut key is defined.
Ctrl +V: The sequence Ctrl V is to be used as the paste shortcut.
Alt + V: The sequence Alt V is to be used as the paste shortcut.

Marking/Copy:
Use shift+arrow keys for marking (off)
When selected allows shift + arrow keys to be used for marking.

Trim trailing spaces on copy (on)
When selected deletes any spaces from the end of the selected text.

>
>
>

>
>
>



Shift+arrow marking mode (Rectangular marking):

Continuous marking:  This highlights a continuous line of text from the display area. The selection 
starts at the row and column location corresponding to the current cursor position when the command 
was issued and includes all partial and complete lines of text up to the location at which the keys are 
released.
Rectangular marking: This highlights a rectangular portion of the display area.

Pause when marked (on)
Places the screen into a paused stated until marking/copy is completed.

Paste:
End-of-line text ({Return})
The character that will be appended to the end of the pasted line.

End-of-field text ()
The character that will be appended to the end of the pasted field.

Field separator text ()
The character that will be appended to the end of each pasted field.

Start text ()
Text which will be prepended to the pasted text.

End text ()
Text which is appended to the pasted text.

Line delay (ms) (50)
The time delay in milliseconds between each pasted lines.

Character delay (ms) (0) 
The time delay in milliseconds between each pasted character.

License

This option is reserved for future use.

User Details

Login name ()
This information is made available for use as a macro command.

Password ()
This information is made available for use as a macro command.

>

>
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Capture

Compress diagnostic captures (on)
Deselect if you do not wish the diagnostic capture file to be compressed.

Compression Level (9 (best compression))
Enter a value from 1 (fastest, minimal compression) to 9 (slowest, best compression).



Chapter 15: Macros

Creating and using Macros.
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Macros
Macros can be simply described as a string that provides the ability to execute several operations consecutively 
from one initiating action. This is done by constructing the macro from a combination of text and "tokens", 
these "tokens" representing such functions as ASCII control codes, emulation keys, predefined TTWin Lite 
functions and so on.

Format

A TTWin Lite macro consists of standard text which is sent to the host, with embedded tokens. The tokens 
are either translated into text (e.g. \r) or perform an action (e.g. pause). Tokens can be grouped into two main 
categories:

C-Style text replacements
Brace enclosed tokens

C-Style Replacement Tokens
These tokens start with a backslash and translate to a single character value.

Token Character Code

\r 13, 0x0D (CR)

\n 10, 0x0A (LF)

\t 9,  0x09 (TAB)

\b 8,  0x08 (BS)

\f 12, 0x0C (FF)

\xnn Translates to the hex code nn. Can be 2 to 4 digits, giving values 
from 0 to 0xFFFE

\c Removes any special meaning from the character c. E.g.

\\ The backslash character

\{ The character { rather than the start of a brace token.

\e’name’ Replaced with the value of the environment variable name	 For 
example, \e PATH would return your current PATH settings..

\pnnn Pause the macro where nnn is in tenths of a second.

\v’name’ Replaced with the user variable name from the [UserDetails] of the 
config file.

\U'url' Launch the default browser with the given url.

>
>



Brace Enclosed Tokens
These tokens are enclosed in curly braces {}. They are can be further broken down into one of the following 
types:

Function calls  (e.g. {.Connect()} )
Flow control statements (e.g. {%if(r=0)} )
Emulations keys (e.g. {F1} )

Function Calls
Function Parameters Action

{.ClearScreen()}
Clears the screen. 

‘r’ register left unchanged.

{.Close()} Close the application

{.Connect()}
Attempts to connect.

Result placed in ‘r’ register

{.Disconnect()}
Attempts to disconnect.

Result placed in 'r' register

{.EnvVar(var)} var = name of an environment 
variable

Sends the value of the environment 
variable.

‘r’ register left unchanged.

{.MsgBox(text)} text = text message

Shows a message box with OK & 
Cancel buttons. Cancel button exits the 
macro.

‘r’ register left unchanged.

{.Pause(period)} period = pause time in tenths 
of a second

Pauses macro execution.

‘r’ register left unchanged.

{.SetProp(name,value)}
name = property name,

value = property value

Set the value of a configuration prop-
erty.

{.URL(url)} url = URL to launch
Launch the default browser with the 
given URL.

{.UserVar(var)}
var = name of a property from 
the [UserDetails] config file 
section.

Sends the value of the property.

‘r’ register left unchanged.

>
>
>
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Flow Control Statements
Label {:name}

goto {%goto :label}

if
{%if(expr)} .. 
{%endif}

expr = a restricted boolean 
expression. Seel below.

while
{%while(expr)} ... 
{%wend}

expr = a restricted boolean 
expression. See below.

exit {%exit} exits a macro

Restricted Boolean Expressions
A limited boolean expression restricted to the form

<ident><op><const_value>

where

<ident> = a variable identifier. Currently on the result register ‘r’ is recognised.

<op> = One of =, <>, <, >, <=, >=

<const_value> = a numeric constant.

Emulations Keys
Brace enclosed tokens consisting of a single identifier are interpreted as emulation keys. 

{F1}

{Enter}

Macro Examples

	Tries to connect and shows a message box if successful.

{.Connect()}{%if(r=0)}{.MsgBox("Connected!")}{%endif}

	Continually displays a message box until the cancel button is pressed.

{:start}{.MsgBox("Hello")}{%goto :start}

	Connects and logs in.

{.Connect()}{%if(r<>0)}{.MsgBox("Connect failed"){%exit}{%endif}mylogin\
n{Pause(20)}mypassword\n



Host Initiated Macros

This section only applies if you are able to modify applications or write programs 
for your host. 

It is possible to automatically trigger events in TTWin Lite in response to sequences sent from the host. One 
way to do this is to use a host initiated macro.

The first step is to set up a macro trigger sequence in TTWin Lite. Sending the trigger sequence from the host 
is dependent upon the host’s operating system. You will need to be familiar with the operating system on your 
host.

For example in a UNIX environment you can use an ECHO command in a shell script.

If, after consulting your operating system literature, you require further assistance please contact Turbosoft for 
guidance. 

Defining Host Initiated Macros

From the TTWin Lite menu select Config > General > Host initiated macro, refer to Figure 29.  There 
are two sections in the definition of a host initiated macro:

Figure 29. TTWin Lite host macro configuration.
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Macro Prefix/Trigger sequence
The trigger sequence is defined with the Macro prefix string. It is recommended that you define a sequence 
that is unlikely to occur. For this reason ESC is not a good character to start the sequence. An example trigger 
sequence is \x1f~, where \x indicates that the next two characters are a hex value, i.e., 1F.

Macro
Up to 10 macros can be defined with the MacroN string. Alternatively, a delimited macro can be sent in the 
host stream prefixed by m. 

Macro timeout (200)
Enter the maximum time allowed to execute a macro, shown in milliseconds. 

Interpretation of the Input Stream

When running the session, TTWin Lite scans the input stream for the trigger sequence defined with the Macro 
prefix or trigger string.

After recognising the trigger, TTWin Lite looks for the next character and responds as follows:

Character 	 Response

0 		 The macro defined by the profile string Macro0= is executed.

9 		 The macro defined by the profile string Macro9= is executed.

For example, given the following session settings,

Macro prefix=\x1f~

Macro0=cd ~\n\p020ls -las\n

Where:

cd ~\n 	change to the user's home directory

\p020 	pause for 2.0 seconds

ls -las\n generate an extended directory listing

For information on using macros to automate a login, refer to Chapter 9..



Chapter 16: Communications

Setting up the type of communications 

(transport) module.



81TTWin Lite User Guide : Chapter 16 - Communications

Communications Configuration
The communications configurations determines the method of connection to your remote host and ensures all 
data transmission is accurate and dependable.

Selecting a Communications Module

Open the communications modules configuration by selecting Config > Comms from the main menu. This 
will bring up the communications dialog which is configured to Telnet by default.

To choose a different comms module select the current comms title (the top item in the list) and then click the 
Select Another… button as shown in figure 30.  The Module Selection tile is displayed listing the addition-
al communications modules available.

Figure 30. Selecting a communications module



Serial Comms

Serial Comms

Port name (COM1) 

Specify the serial communications port to be used. Valid options are COM1 through to COM32

Baud rate (9600) 

Specify the required speed from the following:

300
600
1200
2400
4800
9600
19200
38400
57600
115200
128000
256000

Data Format

Parity (None)
Specify the parity required 

None
Odd
Even
Mark
Space

Byte Size (8) 
Specify the byte size required.

Stop Bits (1) 
Specify the stop bit required 

1
1.5
2

>
>
>
>
>
>
>
>
>
>
>
>

>
>
>
>
>

>
>
>
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Flow Control

Software
From Host (on):
Selected if the flow controlled is initiated by the host.

To Host (off):
Selected if flow controlled by TTWin

Start (Xon) (17):
Default setting is 17(dec) – Control Q (^Q)

Stop (Xoff) (19):
Default setting is 19(dec) – Control S (^S)

Hardware
Select either the To Host or From Host combination

To Host CTS (off):
Select Clear-To-Send

To Host DSR (off):
Select Data-Set-Ready

From Host DTR (on):
Deselect Data-Terminal-Ready

From Host RTS (on):
Deselect Request-To-Send

Control Lines

Ignore DCD (off) 
This option is required when running TTWin over a direct connection where the Carrier Detect Pin is not 

connected.

Drop DTR (on)
Drops the DTR signal in order to hangup.

Disable DTR (off)
Disables the DTR signal.

Break Duration (milli secs.) (100)

The Break period is defined in milliseconds.



Buffers

Send Buffer Size (2048)
Internal TTWinCE data buffer settings.

Receive Buffer Size (2048)
Internal TTWinCE data buffer settings.

High Flow Mark (0)
For initiating flow control.

Low Flow Mark (0)
For initiating flow control.

Debug 

Log File (c:/serial.log) 
Selecting the Log file command activates the Browse tile. Enter or select the name of the file to which you 
wish to have the log information saved to.

Enable (off) 
Select this to enable log file capture.

Verbosity (0-9) (0)
Select a value from 0 (least verbose) to 9 (most verbose).
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Telnet (default)

Connection

Host () 
Selecting the host tab allows you to enter the IP address of the remote host you wish to connect to. This is 
used when you only wish to connect to the same host and will be saved within the configuration file.

Use TCP IPv6 (off)
When set to on the telnet seesion will utilize the IPv6 protocol. If entering an IP number into the Host field 
please ensure it follows the correct IPv6 format. 

LU Name () 
This is used to identify the terminal as an LU (Logical Unit) to an IBM Mainframe. 

Associate ()
This option has no effect unless you are using the IBM3287 printer emulation. This is used to associate an 
existing Terminal LU (Logical Unit) to this session.

The LU name and Associate options are mutually exclusive.

Advanced

Port No (23) 
This is an integer that identifies the destination within the remote host 23 is reserved for Telnet, 21 for FTP.

Prompt for Host (on) 
Deselect this if you do not wish TTWin Lite to prompt you for an IP address.

Tn3270eEnabled (off) 
Select this if you wish to enable the extended attributes when using the 3270 emulation.

Security
Security ([none])

[none]: no security enabled (standard telnet).
SSL: uses SSL3 encryption
SSH Tunnel: uses SSH encryption

Strict (off) 
If selected the host RSA key must match the key listed in the known hosts file.

>
>
>



SSL
CertStore (My) 

Enter the name of your certificate store.

Certificate () 
The name of the certificate within the selected store.

SSH Tunnel
Host () 

Enter the IP address of the SSH host.

Port No (22) 
Enter the port number to be used for the SSH service.

Username () 
Enter the username for the SSH service.

Password () 
Enter the password for the SSH service.

Terminal
Override terminal characteristics (on)
TTWin Lite will automatically supply the most appropriate Terminal Type and Telnet Mode for the Telnet 
connection. Select this option to override the supplied Terminal Type and Telnet Mode.

Terminal Type ()
The Telnet protocol allows the terminal to inform the host, or the host to ask the terminal, for a terminal 
type identifier (such as VT100). This allows the host to correctly setup terminal-specific variables such as 
the codes to clear the screen. This option is only available when Override Terminal Characteristics is select-
ed.

Telnet Mode (NVT)
The type of Telnet communications between your local machine and the remote host can vary depending 
on the type of emulation you are using. The available settings are 

NVT 
IBM3270
IBM5250

This option is only available when Override Terminal Characteristics is set to on.

Telnet Options
Transmission Type (0) 

Binary (off) 
All data is handled as 8 bit characters. There are no additional functions performed on characters such as 
end-of-line, or any other ASCII characters. This option is mutually exclusive with Line Mode. 

>
>
>
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CR Handling (0)

Line Mode (off)
In Line Mode characters, like the end-of-line character, are translated. Line Mode is also known as character 
mode. 

Remote Echo (on)
When selected all data must first go to the remote host, then on return it is displayed on your screen.

‘Break’ Action ()
Set the Break Action , available selections are

Interrupt
Break
Abort Output
Sync

Option Negotiation
Initiate Negotiation (off)
A Telnet connection is generally initiated from the remote host. Selecting this option forces the Telnet 
negotiation to start from the TTWin end. 

Show Negotiations (off)
When selected, the Telnet negotiation during the initial connection is shown.

Miscellaneous
Keep Alive (secs.) (0)
Typically used on a dial on demand connection, e.g. DSL, during period on inactivity TTWin will poll the 
host to keep the connection alive. The poll interval is defined in seconds.

Send Location ([none])
Sends a location identifier, valid selection types are

[none]
String
Hex IP
Decimal IP

Location ()
Enter your location ID based upon the selection above.

>
>
>
>

>
>
>
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IBM5250 Options
User () 
Enter the username for TN5250 connections.

Password () 
Enter the password for TN5250 connections.

Encryption Required (off) 
Indicates whether the user and password fields require 3Des encryption.

MSGQNAME ()
5250 environment parameter. Please refer to your host documentation.

MSGQLIB ()
5250 environment parameter. Please refer to your host documentation.

IBMCURLIB ()
5250 environment parameter. Please refer to your host documentation.

IBMIMENU ()
5250 environment parameter. Please refer to your host documentation.

IBMPROGRAM ()
5250 environment parameter. Please refer to your host documentation.

Debug

Enable Debug (off)
Select this to enable log file capture.

Debug Level (0)
Select a value from 0 (least verbose) to 9 (most verbose).

Debug Log File ()
Selecting the Debug Log File command activates the Browse tile. Enter or select the name of the file to 
which you wish save the debug information to.

Silent Errors (off)
When set to on this disables notification of TCP stack errors.
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HPNS VT

Host ()

Selecting the host tab allows you to enter the IP address of the remote host you wish to connect with. This is 
used when you only wish to connect to the one host, the setting will be saved within your configuration file.

Advanced

Local NS nodename ()
The NS name of the Local PC, used to identify the terminal to the remote host.  Consists of three labels rep-
resenting host.department.organisation i.e. PC31.DEV.TURBOSOFT.

Use custom prompt (off)
When enabled the prompt string sent by the host is replaced by the users customized string. 

Custom prompt ()
Enter a custom prompt string. Maximum length 8 characters.

Stream mode (off)
TTWin Lite's VT protocol supports the newer Stream Mode connection as well as the standard Message Mode.  
Enable this option to try to establish a Stream Mode connection first, if it fails HP VT will automatically fall 
back to Message Mode.

Display diagnostics (off)
Enabling this feature displays various diagnostic messages during connection establishment.

Verbose (0) 
Debug setting. Select a value from 0 (least verbose) to 9 (most verbose).

Silent Errors (off)
When set to on this disables notification of TCP stack errors.



SSH – Secure Shell

Connection

Remote host address ()

Selecting the host tab allows you to enter the IP address of the remote host you wish to connect to. This is 
used when you only wish to connect to the same host and will be saved within the configuration file.

Port No (22)
Assign the port number you are using.  The default is 22, as this is the port that is reserved for SSH.

Use TCP IPv6 (off)
When set to on the telnet seesion will utilize the IPv6 protocol. If entering an IP number into the Host field 
please ensure it follows the correct IPv6 format.

User Details
Login name ()
Enter the default login username.

Password ()
Enter the password for the login username.

Please consider your corporate security guidelines prior to implementing the User 
Details entries. 

Prompt for host (on) 
Deselect this if you do not wish TTWin Lite to prompt you for an IP address.

Terminal

Override Terminal Type (off)
TTWin Lite will automatically supply the most appropriate Terminal Type for the SSH connection.  You may 
need to override this depending on your host’s SSH support. 

Terminal Type ()
The SSH protocol allows the terminal to inform the host or the host to ask the terminal for a terminal type 
identifier (such as VT420), to allow the host to correctly setup terminal-specific variables such as the codes to 
clear the screen.
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Security

Strict Security (off) 
If selected the host RSA key must match the key listed in the known hosts file.

Debug

Enable Debug (off)
Select this to enable the log file capture.

Debug Level (0-9) (0)
Select a value from 0 (least verbose) to 9 (most verbose).

Debug File (c/ssh.log)
Selecting the Debug File command activates the Browse tile. Enter or select the name of the file to which 
you wish to save the debug information to.



Chapter 17: Emulations

Configuring your required terminal emulation.
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Emulation configuration
Emulation configuration options for the various terminals emulated by TTWin Lite.

Selecting an Emulation Module

Open the Emulation module configuration tile by selecting Config > Emulations from the main menu. This 
will bring up the communications tile which is configured to DEC VT420 by default.

To choose a different emulation module select the current emulation module title (the top item in the list) and 
then click the Select Another… button as shown in Figure 31.  The Module Selection tile is displayed listing 
the additional emulation modules available.

Figure 31. Selecting an emulation.

Configuration options for each of the Emulation modules supported by TTWin Lite are listed as follows:

ANSI Color

Display Mode

Display Size (80x24) 
Available options are

80x24
132x24
Custom: uses the width and height as defined in the next 2 options.

>
>
>

>



Custom Height (24)
Enter the number of rows required.

Custom Width (80)
Enter the number of columns required.

Options

Autowrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received. 

LF to CR/LF (Received) (on)
If selected then on receipt of a linefeed (LF) from the remote host TTWin Lite performs a carriage return (CR) 
as well as a linefeed.

Edit Mode (Overstrike)
Available options are:
Insert: Inserts incoming text at the position of the cursor. Existing text will be moved to the right to make 
space.
Overstrike: From the current cursor position overwrites text to the right on the current line.

Special character set (off)
The ANSI emulation supports two styles of box drawing characters, these are single line (default/off) or double 
line (on) box drawing.

No gaps in underlines (on)
Select if you do not want gaps in underlines.

Erase with current attribute (on)
When selected, the current character attribute will be used when an erase operation is performed.

Advanced
MapSingle (off)

SingleMapChar (155)

Set colors in Normal (on)

>
>

>
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Character Mapping

LanguageName ()
Selecting this option presents a drop down menu of languages English, English (UK), Dutch, Finnish, French, 
French/Canadian, German, Greek, Italian, Norwegian/Danish, Spanish, Swiss, Swedish, Cyrillic.

Character Sets
This configuration option allows editing of various character sets. The LanguageName setting must be config-
ured prior to editing these settings.

ASCII
Extended ASCII
Graphics (single line box characters)
Single line box drawing character set.

Graphics (double line box characters)
Double line box drawing character set.

To host



HP Series

HP Model (MODEL_70092)

Select an Hewlett Packard terminal model. Available options are:

MODEL_2392A
MODEL_70092
MODEL_70094

Display Width (80 column) 

Select from the two available options, 80 column or 132 column

Main

User Terminal ID (70092) 
Select from the two available options 2392A or 70092. 

Field separator char (31)
Must be an ASCII character. When you press the ENTER key while the terminal is in block page mode and 
display memory contains a formatted display, the terminal automatically transmits the specified field separator 
character at the end of each protected field (except the final one). 

Block terminator char (30)
Can be any ASCII character. For data transfers between the terminal and a host computer, the terminal trans-
mits the specified block terminator character at the end of the transfer operation. 

Local echo (off)
If selected, characters entered through the keyboard are displayed on the screen and transmitted to the host 
computer. When not selected, characters entered through the keyboard are transmitted to the host computer 
only. If they are to appear on the screen, the host computer must echo them back to the terminal. 

XmitFnctn (0)
This field specifies whether the escape code functions are both executed at the terminal and transmitted to the 
host computer.

InhHndShk (off)
See InhDC2.

CAPS locked (off)
This field specifies whether the terminal generates the full 128-character ASCII set or only the Teletype-com-
patible codes.

Space overwrites/advances (off)
This field specifies whether or not spaces entered through the keyboard will overwrite existing characters.

>
>
>
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InhDC2 (off)
Together, InhHndShk and InhDC2 fields determine what type of handshaking is to be used when transferring 
blocks of data from the terminal to the host computer.

InhEOLWrap (off)
This field specifies whether or not the end-of-line wrap is inhibited.

EscXfer (0)
This field controls the transfer of escape sequences to a printer, and has no effect if there is no second port. 

Margin bell (off)
This specifies whether the terminal's bell is enabled or disabled. If not selected, the bell will still sound in 
response to an ASCII Bell control code (decimal 7, [CTRL_G]).

StartCol (1)
This is a value in the range 1 – 80. 

LinePage (Line)
This field specifies whether or not the terminal, when operating in Block mode, will transmit data a line at a 
time or a page at a time.

Modes

LF to CR/LF (on)
Converts a LF to a CR/LF. 

Smooth scroll (0) 
When selected (1), rolling data up and down the screen is done smoothly. When not selected (0), the scroll 
jumps a line at a time. 

Auto linefeed (0)
When selected a line feed control code is automatically appended to each carriage return control code generated 
through the keyboard.

EnqACK (1)
When selected, all ENQ characters from the incoming data are stripped off and in turn responds by transmitting 
an ACK. When de-selected, all incoming characters (including ENQ and ACK but excluding NULLS and DELS) 
are treated as data bytes, NULLS and DELS are stripped from the incoming data.

Insert mode (0)
This option determines how characters are added to the screen. When selected, the character is inserted at 
the cursor, moving previously displayed characters to the right. When not selected, new characters replace old 
characters at the cursor position. 

Format (0)
When selected, the terminal user can only enter data into unprotected fields. 



LineModify (0)
When the terminal is in Remote mode and Character mode and you are communicating interactively with a 
host computer, you may sometimes enter an erroneous command string to which the computer responds with 
an error message. If the command string is a lengthy one and the error consists of only a few characters, it is a 
nuisance to have to retype the entire string. In such a case, you may instead enable Line modify mode (which 
temporarily switches the terminal to a special form of Block mode). You can then move the cursor to the 
erroneous line on the display and correct the command string. When the string is edited to your satisfaction, 
you retransmit the line to the host computer by pressing either the [ENTER] key or the [RETURN] key. Line 
modify is automatically disabled when you press either [ENTER] or [RETURN]. 

ModifyAll (0)
When the terminal is in Character mode, you can enable Modify All, which switches the terminal to a special 
form of Block mode. Modify All is the same as Line Modify except that it is NOT disabled when you press 
[ENTER] or [RETURN]. 

Block mode (0)
When not selected, the terminal operates in Character mode. In Character mode, data is transmitted a char-
acter at a time as it is entered through the keyboard. Control codes (such as CR and LF) are also transmitted. 
When selected, the terminal operates in Block mode. In Block mode, data is NOT transmitted at the time it 
is entered through the keyboard. Instead, you transmit an entire block of data by first typing the data and then 
pressing the [ENTER] key. When the terminal is in Block mode, control codes (such as CR and LF) are acted 
upon locally but NOT transmitted with the data block. 

Remote (1)
When selected, if you press an alphanumeric key the associated character code is transmitted to the host com-
puter. When not selected (Local mode), if you press an alphanumeric key the associated character is displayed 
at the current cursor position on the screen. Nothing is transmitted to the host computer. 

DisplayFns (0)
When selected, the terminal operates as follows In Local mode, it displays control codes and escape sequences 
but does not execute them. In Remote mode, it transmits control codes and escape sequences but does not 
execute them locally. 

Record (0)
Record mode copies from the host to the selected destination (to) device, e.g., an external printer. When the 
Record mode is not selected, the contents of a partially filled buffer will be sent to the destination device(s). 

LogBottom (0)
Logging is a mechanism whereby data can be automatically routed to an external device e.g., a printer. With 
bottom logging, each time the cursor moves from one line to another, the line from which the cursor moved is 
sent to the external device. 

LogTop (0)
When the display memory is full and another line of data is entered, the top line in the display is purged to 
make room for the new line. With top logging, each purged line is sent to the external device. Thus, while the 
line is lost from display memory, it is maintained in hard copy form. 
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Send cursor pos (off)
When selected, if the ENTER key, SELECT or a user defined key (set to transmit) is pressed, the current cursor 
position is sent to the computer. 

AutoKbdLock (off)
When a terminal is connected to a packet switching network (using X.25 protocol) via a controller/multiplexer, 
it is necessary to ensure that the packet sent is received and acted upon before another is sent (from the termi-
nal). In order to achieve this, the keyboard must automatically lock, in such a way that it can only be unlocked 
by the receiving host. 

Type-ahead (on) 
While the keyboard is locked, keystrokes are stored and released when the keyboard is Unlocked.

Type-ahead limit (100) 
The number of keystrokes permitted whilst keyboard is locked before the buffer fills and locked state is 
resumed.

Type-ahead delay (0)
This setting gives the delay between each key when the type-ahead buffer is purged; i.e. its contents sent to the 
host. Measured in milliseconds.

HostPrompt Text (17) 
Decimal ASCII character value used by the host prompt. 

Enable host-prompt (on)
Uses a host originated user-definable character value to release the keystrokes, stored previously via Type-
ahead.

ReturnIsEnter (0) 
This is the flag to make the [RETURN] key (on main keyboard) act like the [ENTER] key (num pad). 

ReturnDefn ()
Sets the character string assigned to the [RETURN] virtual key using the TTWin Lite string parsing language. 
Limited to a maximum of 2 characters, and if no string is provided then defaults to \r (carriage return).

TAB is spaces (off)
When selected, the [TAB] virtual key produces the number of spaces required to reach the next tab stop to 
the right. When not selected, the [TAB] key behaves as normal, (i.e., sends a tab character). Similarly, this flag 
causes BACK TAB to send out the required number of backspace characters (^H) to reach the nearest tab stop 
to the left. 

NumpadTab (TAB)
Configure the numpad [TAB] virtual key to behave as one of the following virtual keys 

TAB
RETURN
ENTER

>
>
>



Destructive backspace (off)
With Destructive Backspace, pressing BACKSPACE moves the cursor back one character and clears the charac-
ter. Normally, BACKSPACE moves the cursor back one character but the character is not cleared.

Disable block-mode (on)
When not selected, the terminal operates in Character mode. In Character mode, data is transmitted a char-
acter at a time as it is entered through the keyboard. Control codes (such as CR and LF) are also transmitted. 
When selected, the terminal operates in Block mode. In Block mode, data is NOT transmitted at the time it 
is entered through the keyboard. Instead, you transmit an entire block of data by first typing the data and then 
pressing the [ENTER] key. When the terminal is in Block mode, control codes (such as CR and LF) are acted 
upon locally but NOT transmitted with the data block.

8-Bit mode (on)
This enables 8 bit data input streams.

Function keys

This option allows the user to assign functions and labels of their choosing to the first eight function keys. 

F1-F8 
Give the command to be executed when the appropriate function key is pressed. Each function key can be 
assigned a definition string or macro of up to 80 characters.

F1-F8 Attribute (Normal) 
The attribute is selected from the following options. 
Normal: The key definition string acts as data entered normally from the keyboard. 
Transmit: For transmission only. The key definition string is sent to the host. It is not echoed locally. 
Local: For local use only. The key definition string is sent to the screen. It is not transmitted to the host.

F1-F8 Label 1 (“”) 
Specify the first line of text to appear on the displayed key. 

F1-F8 Label 2 (“        “) 
Specify the second line of text to appear on the displayed key.

Character Mapping

LanguageName ()
Selecting this option presents a drop down menu of languages: Danish, Dutch, English, English (UK), Finnish, 
French, French/Flemish, French/Canadian, German, Italian, Norwegian, Spanish - European, Spanish - Latin, 
Swedish, Swiss French/German..

Character Sets
Standard map
Line drawing characters
Display functions map

>
>
>
>
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ASCII
Special graphics
To host

IBM 3270

Models

Fujitsu Mode (off) 

If selected the following Fujitsu terminals are supported

6681-2	 24 x 80 display
6681-3	 32 x 80 display
6681-4	 43 x 80 display
6681-5	 27 x 132 display
6681-6	 27 x 136 display

IBM3270
Supported IBM 3270 terminals include the 3278 and 3279 models.

Model – IBM (3279-2 24x80) 
3278-2 Offers support for a 24 line x 80 column display
3278-3	 32 x 80 display
3278-4	 43 x 80 display
3278-5	 27 x 132 display
3279-2	 24 x 80 display
3279-3	 32 x 80 display
3279-4	 43 x 80 display
3279-5	 27 x 132 display

Extended Attributes (off) 
Select to enable additional terminal characteristics.

Fujitsu 
Mode (Mode 1) 
This is dependent upon your host system. It affects the handling of colors. Options available are mode 1 
and 2.

Log Mode ID () 
This is a two digit number used by the host. It is required for the telnet setup and it MUST come from 
your systems administrator.

Extended Data Stream (off)

Colors

>
>
>
>
>

>
>
>
>
>
>
>
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IBM3270 Default Colors 
Available colors are Black, Blue, Red, Pink, Green, Turquoise, Yellow, Deep Blue, Orange, Purple, Pale Green, 
Pale Turquoise, Gray, White.

Alpha (Green)
Protected (Blue)
Numeric (Green)
Protected Numeric (Blue)
Highlight Alpha (Red)
Highlight Protected Alpha (White)
Highlight Numeric (Red)
Highlight Protected Numeric (White)

Fujitsu Colors 
Available colors are Black, Blue, Red, Pink, Green, Turquoise, Yellow, Deep Blue, Orange, Purple, Pale Green, 
Pale Turquoise, Grey, White.

Green (Green)
Red (Red)
White (White) 

Advanced 

Status Line Display (Plain)
There are three possible status lines plain, average response, and last response.

Enable ‘dot’ facility (off)
This option places a dot in input fields for every character.

Enable TypeAhead (off)
While the keyboard is locked, keystrokes are stored and released when the keyboard is unlocked.

TypeAhead Size (100)
The number of keystrokes permitted whilst keyboard is locked before the buffer fills and locked state is 
resumed.

DBCS Enabled (off)
Select to enable DBCS support (Double Byte Character Set).

DBCS Code Page (950)
Sets the code page to be used when DBCS is enabled.

Miscellaneous
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ScreenSizeSwitching (off)
Controls whether screen size changing is permitted.

Terminal Reset Clears Screen (off)
ClearPadding (off)
ClearPad (0)
Destructive Backspace (off)
With Destructive Backspace, pressing [BACKSPACE] moves the cursor back one character and clears the 
character. Normally, [BACKSPACE] moves the cursor back one character but the character is not cleared.

Honour Numeric Field Type (off)

Create Debug Log (off)
Select this to enable the log file capture.

Debug Log File (c\ibm3270.log)
Selecting the Debug file command activates the Browse tile. Enter or select the name of the file to which 
you wish to save the debug information to.

Character Mapping

LanguageName () 
Selecting this option presents a drop down menu of languages: English (US), English (UK), Austrian/German, 
Belgian, Canadian (French), Danish/Norwegian, Finnish/Swedish, French, Greek, International, Italian, 
Japanese, Spanish, Spanish Speaking.

Character Sets
Standard character set
Graphics character set
ASCII to EBCDIC
EBCDIC to ASCII
To host



IBM 5250

Model (IBM 3477-FC)

Support for the IBM5250 terminal modes is extensive. Currently supported modes are:

3179-2
3179-220
3180-2
3196-A1
3477-FG
3477-FC
5251-1
5251-11
5252
5291-1
5292-2
IBM Printer

Options

Enable TypeAhead (off)
While the keyboard is locked, keystrokes are stored and released when the keyboard is unlocked.

TypeAhead Size (100)
The number of keystrokes permitted whilst keyboard is locked before the buffer fills and locked state is 
resumed.

Protect Saved Screen (off)

Dot Attribute (Dots)
Enables or disables dot attributes.

Advanced
Max. Packet Size Buffer (kb) (4)
Generate TN5250log (off) 
Select this to enable the log file capture.

Log file (c:\ibm5250.log)
Selecting the Debug file command activates the Browse tile.  Enter or select the name of the file to which 
you wish to have the log information saved to.

Honour Numeric Field Type (on)

>
>
>
>
>
>
>
>
>
>
>
>
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Character Mapping 

LanguageName ()
Selecting this option presents a drop down menu of languages Austria/Germany, Belgium, Canadian French, 
Denmark/Norway, Finland/Sweden, France, Italy, Portugal, Spain, United Kingdom, U.S./Canada/Netherland.

Character Sets
Standard character set
ASCII to EBCDIC
EBCDIC to ASCII
To host

Linux Terminal

Autowrap (on)

When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

Columns (80)

Select to change between 80 and 132 column modes.

Custom Screen Size (off)

Select to enable the custom sizes as defined below.

Custom Lines (25)

Enter the number of rows required.

Custom Columns (80)

Enter the number of columns required.

Character Mapping

LanguageName ()
Selecting this option presents a drop down menu of languages.



Character Sets
HostsNational
ASCII
ASCII (8 bit)
DEC Special Graphics
DEC Supplemental
To host
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SCO ANSI Color Console

Display

Screen Width (80) 
Enter the number of columns required.

Screen Height (24) 
Enter the number of rows required.

Options 

Autowrap (on) 
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received. 

Clear screen on width change (on) 
When selected, this will cause a screen clear whenever a switch between 80 and 132 columns occurs. If history 
is enabled, the screen data is moved to the scroll history buffer, otherwise it is lost.

Answerback

Send Answerback (on) 
Transmit the string defined within the Answerback Message String field when the ENQ character is 
received from the remote host. 

Answerback Message String () 
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Printing

Disable non-printable chars (on) 
Select to enable non-printable characters to be passed on to the printer.

Enable special printing (on)
Print line termination (None) 
Options available include: 

None
CR, LF
CR/LF
LF/CR

>
>
>
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Printer acknowledgement char (13) 
Decimal character value.

Enable Transparent Print (on) 
Deselect if you wish to disable transparent print function.

Character Mapping

LanguageName ()
Selecting this option presents a drop down menu of languages: English, English (UK), Dutch, Finnish, French, 
French/Canadian, German, Greek, Italian, Norwegian/Danish, Spanish, Swiss, Swedish (437), Swedish (850), 
Cyrillic.

Character Sets
Low Character Set
High Character Set
US ASCII set
UK ASCII set
Graphics set
To host
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DEC VT 420 (Default)

Display Size

Lines (24) 
Select to change between 24, 36 and 48 line modes.

Columns (80) 
Select to change between 80 and 132 column modes.

Custom Screen Size (off) 
Select to enable the custom sizes as entered below.

Custom Lines (24)
Enter the number of rows required.

Custom Columns (80) 
Enter the number of columns required.

Display Modes 

Local Echo (off)
If selected, as a character is typed on the keyboard it is immediately echoed to your screen. If disabled, the 
entered character is sent to the remote host which in turn echoes it back. On its return the character is dis-
played on your screen. In this way, passwords and other sensitive information do not appear on your screen. 

Insert Mode (off)
This mode determines how characters are added to the screen. When selected, the character is inserted at the 
cursor, moving previously displayed characters to the right. When not selected, new display characters replace 
old display characters at the current cursor position.

Autoscroll (3)

Autowrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

BackspaceOn (off)
Clear using current attribute (off) 
Specifies whether a cleared character retains an attribute.

Clear screen on size change (off)
When selected, this will cause a screen clear whenever a switch between 80 and 132 columns occurs. If history 
is enabled, the screen data is moved to the scroll history buffer, otherwise it is lost.



Inputmode (SBCS)
Select between SBCS, DBCS and UTF-8 character set modes.

Responses

Answerback Message ()
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Operating Mode (VT400)
Select to change between the following modes:

VT52
VT100
VT400

7 or 8 bit (7 Bit)
Select between 7 or 8 bit modes.

Terminal ID (VT 420) 
Select between 

VT100
VT101
VT102
VT220
VT240
VT320
VT340
VT420

Custom DA stdstring (?64;1;2;6;7;8;9;15;18;19;21) 
Enter your custom DA string.

Use Custom DA stdstring (off) 
Select to enable the Custom DA stdstring function.

Keyboard Configuration

Keypad Mode (Application) 
Select between Application and Numeric keypad state. 

Application: Selects application keypad mode. The keypad generates application control functions.
Numeric: Selects numeric keypad mode. The keypad generates characters that match the numeric, period, 
plus, minus, star and forward-slash keys on the main keypad.

>
>
>

>
>
>
>
>
>
>
>

>

> 
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Cursor Keys (Normal)
The characters generated by the cursor keys depend on the state of the Cursor Keys mode. 

Normal: Causes the cursor keys to generate ANSI cursor control sequences.
Application: Causes the cursor keys to generate application control functions.

Keyboard Locked (off) 
When the keyboard is locked, no codes can be transmitted from the keyboard to the Host. You can unlock the 
keyboard either by deselecting this option or resetting the terminal.

Convert LF to CR/LF (off) 
When selected, this causes a received RETURN to transmit as both a CR and a LF. When not selected and a 
RETURN is received only a CR is transmitted. 

User defined keys locked (off)  
The lock parameter determines whether the downloaded key definitions are locked or not, after you load them. 
To unlock the keys you must either deselect user defined keys locked option or a reset is required.

Compose Enabled (off) 
A compose sequence is a series of two or three keystrokes that produce a single character. Pressing the 
COMPOSE CHARACTER key starts the compose sequence.

Advanced

Print Region (Print Region) 
Select Print Region to send just the selected region to the printer or select Print Screen to send entire screen 
contents to printer. 

Print Form Feed (off) 
Send a form feed character at the end of the print job.

Status Display (None)
None: The status line is not displayed. 
Indicator: The status display is always visible.
Host: Host applications can write messages in place of the status line. 

Tilda and Left Quote key (off) 
This option allows the user to define the TILDA/LEFT QUOTE key (i.e., ~/‘ key) to operate either as normal 
or as an escape key sequence. 

Sends escape (on): Redefine the TILDA/LEFT QUOTE key to send an escape key sequence.

Sends tilda/left quote (off): Leave the TILDA/LEFT QUOTE key as normal, i.e., left quote and with the 
SHIFT key, tilda.

User preferred Character Set (DEC Supplemental)
There are two 8-bit character sets and both include the standard ASCII character set and a supplemental set. 

>
>
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DEC Supplemental: DEC Multinational set

ISO Latin

Miscellaneous

NoNumericKeyMap (off)
Disables application and numeric mode for the numeric keypad.

StripCharValue (242)

StripPrinting (off)

StripSingleChar (off)

WangPrivateKeys (off)

ResetClear (off) 
Reset clears the terminal screen.

FavourDiacritics (off)
When enabled uses European characters rather than line draw characters.

CodePage (950) 
Sets the code page to be used when DBCS is enabled. See also Inputmode

Character Mapping

LanguageName () 
Selecting this option presents a drop down menu of languages: English, English (UK), Dutch, Finnish, French, 
French/Canadian, German, Greek, Italian, Norwegian/Danish, Spanish, Swiss, Swedish, Cyrillic, Croation.

Character Sets
HostsNational
ASCII
ASCII (8-bit)
DEC Special Graphics
DEC Supplemental
ISO Latin Supplemental
DEC Technical
To host
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Wyse50/60
Display

Personality (Wyse 60) 
Select from the following:

Wyse 50+
Wyse 60
Wyse 350 (color enhanced).

Number of lines (24)  
Enter the number of rows required.

Number of Columns (80)  
Enter the number of columns required.

Number of Pages (4) 
The Wyse terminal offers the ability to store multiple pages of information. The number of pages you require 
can be specified here. Each page will use part of your system memory.

Options 

Autowrap (Wrap)  
This affects the behavior of the terminal when a character is inserted in the last column of the screen. 

Stop: The cursor remains in the last column position on the same line and all following characters overwrite 
into the same position.
Wrap: The cursor wraps around to the first column of the next line. 

ScrollMode (Scroll)
This affects the behavior of the terminal when a linefeed is issued on the last line. 

Loop: The screen remains unchanged but the cursor loops to the first column of the screen.
Scroll: The screen scrolls 1 line and the cursor remains on the last line. 

Map CR to CR/LF (off)
This option determines the effect of received carriage return (CR) codes. When selected, all received CR codes 
move the cursor to the first column position on the next line i.e., it is interpreted as a CR followed by a line 
feed (LF). When not selected, all received CR codes simply move the cursor to the first column of the current 
line. 

Send ACK (off)
When selected the terminal will send an ACK character on receipt of an ENQ character from the host. When not 
selected the terminal will ignore ENQ characters. 

>
>
>

>

>

>
>



You can configure Send Ack for the Wyse 60 personality however the Wyse 50+, 
like the real terminal, forces SEND ACK to be selected at all times.

Map NULLs to Spaces (on)
When selected NULLs are converted to spaces.

Attribute Extent (Char)
This determines the extent affected by changing the current display attribute.

Char: All characters that are afterwards will have the new attribute.
Line: The existing line will inherit the new attribute.
Page: The entire page will inherit the new attribute.

Clear screen on Width change (off)
When selected, this will cause a screen clear whenever a screen change between 80 and 132 columns occurs. If 
history is enabled, the screen data will be saved to the scroll history buffer otherwise the data is lost.

Backspace Wraps (on)
Allows backspace to move back to previous line. 

Miscellaneous
Printing CR conversion (None) 
Available options are:

None
Strip
CR/LF 
LF/CR

Printing LF conversion (None) 
Available options are:

None
Strip
CR/LF 
LF/CR

Enhanced (off) 

Strip 8th Bit (off) 
Strips the 8th bit from the character.

>
>
>

>
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Allow Local Echo (off)
If selected, as a character is typed on the keyboard it is immediately echoed to your screen. If disabled, the 
entered character is sent to the remote host which in turn echoes it back. On its return the character is dis-
played on your screen. In this way, passwords and other sensitive information do not appear on your screen.

Status Line 

Status Line Type (None)
Across the bottom of the TTWin Lite window will be displayed various status details. There are three choices

None: Hides the status line
Standard

Status Line Location (Top) 
Four options are available 

Top
Bottom
Top Plain
Bottom Plain

Answer Back 

Enable Answerback (off) 
Transmit the string defined within the Answerback Msg field when the ENQ character is received from the 
remote host. 

Answerback Message () 
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Colors 

To implement the large array of colors associated with a Wyse 350 terminal, this emulation takes advantage of 
the Override Color feature in the TTWin Lite Color configuration tile. This mimics the use of attributes to 
associate and display colors in a Wyse 350 terminal. To aid in the set-up of the color associations, three check-
boxes are available. 

Notify a color palette change (off)
Allows an administrator to know what palette, if any, is been asked for by the host application. The palette can 
be set-up as a color scheme in the Color configuration tile. The user can also be notified when to change the 
color scheme for an application when colors are important to its usage. 

Notify a color association sequence (off)
Applications sometimes add their own flavours to the standard Wyse 350 color palettes. This option allows the 
administrator to change the color schemes accordingly. 

>
>
>

>
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Lock write-protect attribute to Invisible|Blink (off)
TTWin Lite does not have a Write-Protect as a standard overridable attribute. This option maps this attribute 
to a rare attribute, Invisible and Blink, to enable a color to be associated with it. Note that when this option is 
selected, any application request for a change of Write-Protect attribute will be ignored.

Character Sets

Primary Character Set (Font Bank 0)
Selection options available 0, 1, 2 or 3

Secondary Character Set (Font Bank 1)
Selection options available 0, 1, 2 or 3.

Font Bank 0 (G0 Char Map) (Native Mode)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI.

Font Bank 1 (G1 Char Map) (MultiNational)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI.

Font Bank 2 (G2 Char Map) (Native Mode)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI.

Font Bank 3 (G3 Char Map) (MultiNational)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI. 
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Character Mapping

LanguageName () 
Selecting this option presents a drop down menu of languages: English, Swedish.

Character Sets
Native Mode
Graphics Overlay
Multinational
PC equivalent
Standard ASCII
Graphics 1
Graphics 2
Graphics 3
Standard ANSI
ANSI Graphics
UK ANSI
To host



Chapter 18: Colors

Creating and changing the color scheme.
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Color Configuration
The Color Configuration tile allows you to choose or create your preferred terminal color scheme.

To configure the terminal color scheme select Colors… from the Config menu. The Color Configuration 
tile, as shown below appears. Scroll through the sample text list to view the chosen color scheme appearance.

Figure 32. Configure colors.

Color Scheme

The available, predefined, visual attribute color mappings are displayed by clicking on the drop down menu. 
All listed color schemes are stored in your TTWIN.CLR file, allowing several predefined sessions to use the 
same color scheme. 

Save as... 
Select this button to save a new color scheme or make a backup copy of an existing scheme. A new color 
scheme is created using the Change button. 

Remove
Select this button to remove a listed color scheme that is no longer required.  The Remove option is disabled 
when the custom color scheme is selected.

You can not retrieve the color scheme once it has been removed! 



Show attribute combinations

This portion of the configuration tile enables you to tailor those attribute combinations that will be shown 
in the Sample text box. This allows for the fact that some emulations only support a subset of the available 
attributes. Also you may not want to show attribute combinations that have invisible as one of the attributes. 

All 
Selecting All enables all combinations of attributes to be selected in the Sample text box. 

Emulation 
Selecting the Emulation button makes only those attributes which are used by the current emulation avail-
able for mapping. For example, VT220 does not support the Dim attribute while Wyse 60 does. Hence with 
the Emulation option, a color scheme created with VT220 as the current emulation will not include any user 
defined Dim attribute color mappings if later used with the Wyse 60 emulation.  

Include invis.
Checking the Include invisible box will show or hide any attribute combinations that have invisible as one of 
the attributes.

Creating and Changing a Color Scheme 
To create a new scheme, click on the drop down menu on the Color scheme field. Then select either an exist-
ing color scheme to modify or simply choose the (custom) color scheme to start afresh. 

To change an existing color scheme, click on the drop down menu on the Color scheme field. Then select the 
color scheme you wish to modify.

Figure 33. Editing a color scheme.
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To change the selected attribute combination, click on the Change... button. This will open the Edit Attribute 
tile, from here you can assign your preferred color mappings to the available attributes as well as the various 
features for underline, overline and/or strike through features. 

Attributes
The Edit Attribute tile allows any aspect of the attribute combination to be added or removed.

Clicking the mouse on the checkbox adjacent to the features will include or exclude this feature from the cur-
rent selected attribute combination. The features are:

Blink 
Reverse
Underline 
Bold
Overline 
Dim
Strike out
Invisible
Box

Override color
The Override color option determines whether the colors used when mapping the attribute combinations are 
those used by the normal attribute, or are an independent set of colors. If selected, the colors are independent. 
Any change to the color set used by the normal attribute will have no effect on this attribute combination and 
visa versa.  

Override color must be selected before you select the new color from the Color 
palette.

Color palette
The Color palette represents those colors that are available for use in mapping attribute combinations. The 
actual number of colors in the palette display is fixed at sixteen, shown as two banks of eight. 

The foreground color of the attribute being changed, may be selected from the palette by clicking the left 
mouse button on the color required. The letter F marks the selected color as the foreground color.

Similarly, the background color may be changed by clicking the right mouse button on the color required. The 
letter B marks the color as being as the background color.

Remember, if you want to override the colors used by the normal attribute you must select Override color 
before changing the foreground or background color.

>
>
>
>
>
>
>
>
>



Changing the foreground or background colors will change the name of the color 
scheme to custom. If you want to change an existing color scheme you must 
specify the name of the color scheme when you save your changes.

Figure 34. Configure Palette tile.

Palette Configuration

Clicking on the Palette... button activates the Configure Palette tile as shown in Figure 34.

The colors that make up the palette displayed on the Edit Attribute tile (Figure 33) may be changed through 
this tile. 

Current palette entry
A preview of the currently selected palette entry is given beside the Index: entry box.

Index
The number in the Index: field is that of the foreground color. Each color in the color palette is given an index 
number. Starting with the top left hand color as 0 then reading left to right the numbers increase by 1.

For example, in a 16 color palette, the top row is 0 to 7 and the second row is 8 to 15. To change to a different 
color in the Color palette, click on the drop down menu on the Index: field.

Color levels
Having selected the current palette entry, you can vary the color of that entry by varying the Color levels. By 
moving the sliders or by entering the appropriate number for Red, Green and Blue, the saturation of these 
color components in the palette color is changed. Moving the sliders to the right increases the saturation.
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Red:, Green:, Blue: 
The percentage of red, green and blue saturation (respectively) in the new user configured color. The preview 
window next to the Index: field shows the new color.

When the color is as required, click on the OK button. This will move the new color into the Color palette, 
replacing the previous color. All attributes that use this color are changed.

Figure 35. Advanced attribute configuration

Advanced Attribute Configuration

You can set preferences for the way the screen features are shown, the way the bold and dim attributes are 
determined and also which box style to use. Clicking on the Advanced... button on the Color configuration 
tile activates the Advanced Attribute Configuration tile shown in Figure 35.

Preferences
Disable blink in emulation: This enables or disables blinking in an emulation. If selected, text in 
an emulation that has the blink attribute will not blink. 

Disable blink in config window
This enables or disables blinking in the config window. If selected, text in the Color configuration tile that 
has the blink attribute will not blink. 



Disable Invisible in emulation
This enables or disables invisibility in an emulation. If selected, text in an emulation that has the invisible 
attribute will remain visible. 

Disable invisible in config window
This enables or disables invisibility in the config window. If selected, text in the Color configuration tile 
that has the invisible attribute will remain visible.

Bold & dim emulation: 
Bold: Click on the drop down menu on the Bold field, to select the method by which the Bold is deter-
mined.
Dim: The Dim attribute is built up in a similar way to the Bold attribute. Click on the drop down menu on 
the Dim field and select from the list of algorithms.
The Bold and Dim attributes are generated from the normal color by means of an algorithm. The available 
methods being: 
Next color: Select the color with an index number one higher than the color of the text that is bold. If the 
color is the last in the palette, use the first in the palette. 
Previous color: Select the color with an index number one lower than the color of the text that is bold. If 
the color is the first in the palette, use the last color in the palette.
Next group: Select the color in the same position as that of the bold text, but in the next group. If on the 
last group, don't change.
Previous group: Select the color in the same position as that of the bold text, but in the previous group. If 
on the first group, don't change.
Toggle group: Select the color in the same position as that of the bold text, but in either the lower or upper 
bank depending on the bank the color is in.

Box style
The box style will apply to any attribute that has the box feature enabled. The available styles are:

Lines: This will put a single pixel box around each character whose attribute has the box feature enabled.
Raised: This will put a raised box around each character whose attribute has the box feature enabled.
Lowered: This will put a lowered box around each character whose attribute has the box feature enabled.
Raise (shallow): This will put a shallow raised box around each character whose attribute has the box fea-
ture enabled.
Lowered (shallow): This will put a shallow lowered box around each character whose attribute has the box 
feature enabled.
Merge vertically adjacent boxes: If checked, then any groups of vertically adjacent rows will appear as a 
single box, when unchecked each row of characters will be boxed.

Horizontally adjacent characters will not be separated by a vertical line.

>

>

>
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Background Image
TTWin Lite can display a bitmap graphics file (BMP) as the background of each session. The Style (default is 
(none)) setting allows the bitmap to appear in the following ways:

Center :Will display the bitmap centered in the TTWin Lite window, no resizing is done to the image.
Tile: Will fill the background with as many copies of the bitmap as is required.
Stretch: Will resize the bitmap so that it fills the entire background area. 

The file option contains the full path and filename of the bitmap to be used, clicking the ... button allows you 
to browse for the required bitmap.

Figure 36. TTWin Lite session with background image enabled.

Saving a Color Scheme

After creating a new color scheme or editing an existing color scheme, click on the Save As… button on the 
Color configuration tile. The Save Color Scheme tile will appear.

Enter the name for the color scheme in the Save scheme as: field and press OK.

>
>
>



Chapter 19: Keyboard Mapping

Remapping the TTWin Lite keyboard.



127TTWin Lite User Guide : Chapter 19 - Keyboard Configuration

Keyboard Mapping
TTWin Lite's keyboard mapping is extremely flexible and allows you to have as many different keyboard con-
figurations as you require. You can have a different keyboard configuration for each application and/or emula-
tion.

To assist you in the configuration of your keyboard, a standard keyboard mapping file is automatically installed 
with each emulation. If you wish, you can customize this file or design your own. 

With TTWin Lite you have the ability to program just about any key to match an emulation key, to send a 
string or macro sequence.

Global Mappings versus Emulation Mappings

TTWin provides both global and emulation key mappings. Because global mappings are saved in the .TWC 
file, you can use global mappings to enforce a certain key mapping for all the emulations that are also held in 
that .TWC file.

Beneath the global level there is an emulation level where mappings for individual emulations can be defined. 
The emulation mappings are saved in a .KEY file, the key definition file, which forms part of the emulation 
environment.

A global mapping always take precedence over an emulation mapping i.e., global mappings override whatever 
that key is mapped to do in an emulation mapping.

If you only ever want to communicate with one host application using one emulation then global mappings or 
emulation mappings will achieve this. However, if you want to communicate with different applications, per-
haps on different hosts, you may wish to map some keys globally and some keys to the emulations.

Or you may want to communicate with one host and with one emulation, but the host has two applications 
that require different mappings for one or more keys. The majority of keys could then be held as global map-
pings, with the remaining as emulation mappings.

As global key mappings are saved in the .TWC file or session file, you will need to 
configure the keyboard for each session file that you use.



Keyboard Mapping

In keyboard mapping it is important to distinguish between physical keys and emulation keys. The physical 
keys are the keys on the physical keyboard attached to your PC. Emulation keys are the keys found on the ter-
minal being emulated. This may, for example, include the GOLD PF1 key on a VT220 terminal.

There are two approaches to mapping the keyboard:

Mapping an emulation key. When mapping an emulation key it is only possible to map a physical key 
to the emulation key. However, this can prove to be far easier than trying to work through physical PC key 
mappings, although clearly it is not possible to create global mappings this way.
Mapping a physical key. You can map either a string or an emulation key to a physical key. Both global and 
emulation mappings are possible this way. Global mappings take precedence over emulation mappings.

While global mappings are typically used for string assignments they may also be used to run macros or to map 
escape sequences to the keys.

Configuring the Keyboard

When you select the Keyboard... option from the Config menu the Configure Keyboard tile is displayed. The 
physical PC keyboard is always shown in the top of the tile and the emulation keyboard is always shown in the 
bottom of the tile.

Figure 37. Keyboard configuration.

>

>
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The standard mappings are automatically set for the emulation that you have chosen. If you require an alterna-
tive keyboard mapping, please contact Turbosoft with your request.

To assign a physical key(s) to an emulation key follow these 6 steps:

You can use the SHIFT, ALT and CTRL keys together with a physical or emula-
tion key, if required.

Select Keyboard... from the Config menu.  The Configure Keyboard tile is displayed. (Make sure that 
the correct emulation and physical keyboards are selected.)

Click on the emulation key(s), in the bottom half of the tile, you wish to map. The physical key along with 
the shift state currently mapped to the selected emulation key(s) is highlighted in the top of the tile. 

Click on the physical key(s), in the top half of the tile, you want to assign to the selected emulation key. 

To save the mapping, click on the Map button. Emulation mappings are saved in a key definition file. By 
default this is the file DEFAULT.KEY.

Repeat the above steps for all the emulation keys you need to map. 

To save session settings, you must also save the .TWC file by selecting Save from the File menu.

For example, to map the physical PC sequence [CTRL_SHIFT_F6] to the currently selected emulation key, 
scroll down the physical key list and select the F6 key, finally check the Shift and Ctrl boxes.

Mapping Physical Keys

You create mappings for physical keys in three ways, with:

An emulation key from the current emulation, e.g., the VT220 PF1 key. 
A global escape sequence, string or macro, e.g., ^[[1M - the ANSI sequence for bold text. 
An emulation specific escape sequence, string or macro.

Global mappings take precedence over emulation mappings.

1�

2�

3�
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To map an emulation key, global or emulation string to a physical key or key sequence, follow these steps:

You can use the [SHIFT], [ALT] and [CTRL] keys together with a physical or 
emulation key, if required.

Select Keyboard... from the Config menu, the Configure Keyboard tile is displayed.

Select the physical key, in the top half of the tile, you wish to map. The emulation key, global or emulation 
string currently mapped to the selected physical key is highlighted or displayed in the top of the tile. 

Select one of:

Emulation key, go to step 4.
String, go to step 5.
Global string, go to step 5.

Emulation key: Click on the emulation key, in the bottom half of the tile, you want to assign to the selected 
physical key. 

String or Global string: You can assign an ASCII data string, an escape sequence or a macro to the physical 
key. Enter the string or macro in either the String or Global string field. 

To save the mapping, click on the Map button. Emulation mappings are saved in a key definition file. By 
default this is the file DEFAULT.KEY. 

Repeat the above steps for all the physical keys you need to map. 

To save session settings and global mappings, you must also save the .TWC file by selecting Save from the 
File menu.

For example, to map the ANSI BOLD escape sequence (ESC[1m) to [CTRL_F6] for the current emulation, 
follow these steps:

Click on the [CTRL] key and the [F6] key on the PC keyboard (top of the tile).

Select String. 

In the String field enter the string: \x1b[1m where \x1b represents the hex value for ESCAPE character. 

Hex values are prefixed by \x

Click on the Map button to save the mapping. 

To save the session settings, select Save from the File menu.
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Removing a Mapping

Click on the Remove button to remove a mapping. Alternatively, re-map BOTH the physical key(s) and the 
emulation key(s).

Saving a Mapping

To save a mapping , click on the Map button. Emulation mappings are saved in a key definition file, i.e., a 
.KEY file. By default this is the file DEFAULT.KEY.

You MUST also save the .TWC file using the Save option on the File menu to secure session settings and glo-
bal string mappings.
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Appendix A

Glossary
ANSI (American National Standards Institute) The U.S. standardization body. ANSI is a member of the 
International Standardisation Organisation (ISO)

API Application Program Interface.

ASCII (American Standard Code for Information Interchange) This is one of the methods of represent-
ing text characters inside a computer.

Attribute This is a way of enhancing characters on screen by adding features such as underline, bold or a 
color.

Break Signal An interrupt signal sent to the host system.

Capture A method used in TTWin Lite, of copying to disk any incoming and outgoing information from the 
remote host.

Certificate File refer to TCF File

Client Any node in a networking environment that initiates a request for a network service.

CR A carriage return (CR) is a control character used to move the cursor position ot the start of a line. Often 
used in conjunction with a line feed (LF). 

DBCS Stands for Double Byte Character Set, using two-byte (16-bit) characters rather one byte (8-bit). 
Typically used to handle languages such as Japanese, Korean and Chinese.

Dialog box A window in a graphical user interface which requests information from the user. In this manual 
dialog boxes are refered to as tiles.

Emulation When used in relation to TTWin Lite, a program that causes the personal computer to act as if it 
were a particular terminal.

Field A defined data area.

Flow control A technique for ensuring that the transmitting device, such as a modem, does not overload the 
receiving device with data. This is also known as pacing.

Function keys A special set of keys which are typically labelled F1, F2 etc. on the keyboard.

GUI (Graphical User Interface) A user environment that uses icons, buttons, windows and pointers etc.

HLLAPI IBM 3270 High Level Language API.

HPNS Hewlett Packard Network Services.



Host Machine on which applications are executed. A host may be the local machine or the remote machine 
connected to via Serial Communication, TCP/IP, etc.

IP number A 32-bit (IPv4) or 128-bit (IPv6) address assigned to hosts using TCP/IP. This consists of a net-
work and host code. The host port is signified by an integer and is used to identify destinations within the host, 
e.g., the port reserved for electronic mail.

LAN Local Area Network.

LF A line feed (LF) is a control character used to indicate a new line. Often used in conjunction with a car-
riage return (CR) . 

Login The action by which you gain access to and establish your identity to a remote host.

Node Any device including servers and workstations that are connected to a network.

Predefined session A session defined within TTWin Lite. See Session.

Remote host The machine which you are communicating with, via your TTWin Lite emulation software.

RS232 A standard used for many serial interfaces. This standard was devised many years ago and many parts of 
it are not used in modern modem equipment. This has led to many different implementations of the standard.

Serial number A unique number allocated to each copy of TTWin Lite software produced by Turbosoft.

Serial port A communications port, generally referred to as COM number. See also communications port.

Session A combination of one emulation and one communications protocol is called a session.

Shift state A sequence of simultaneous key strokes, combining the selected PC key with any of the [SHIFT], 
[ALT] and [CTRL] keys, to generate a unique combination. For example, [CTRL_ALT_F4].

SBCS (Single Byte Character Set) Character sets which use exactly one byte for each character. See also 
DBCS.

SSH (Secure Shell) A communications protocol that allows secure transmission of data.

SSL (Secure Sockets Layer) A protocol that provides security for communications over networks.

Telnet A protocol for providing terminal facilities using TCP/IP across a network.

Tile TTWin Lite terminology for what is commonly known in Windows as a dialog box.

TCF file A TTWin Lite certificate file contain unique licensing information.

TWC file A TTWin Lite Configuration file, storing session configuration options.

X.25 A serial base network communications protcol used for wide area networks.
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Appendix B 

Support 
If you have a support question of issue you need assistance with we recommend firstly checking the sup-
port section of our website (www.ttwin.com) for up to date downloads and documentation. We suggest these 
resources be your first stop as they provide quick answers to many common queries. 

If you are still unable to resolve your issue please feel free to contact Turbosoft's support staff. Full support is 
extended to the holders of maintenance contracts and to those users operating TTWin Lite under an evaluation 
license. To raise an issue with Turbosoft support please log in to http://www.ttwin.com/support (free registration 
required) and fill out an issue form.

When describing your issue be sure to include information on the exact version of the Turbosoft product your 
are using. This information can be obtained by selecting Help > About TTWin Lite 4 > Version from the 
program menu. See Chapter 7 for more information.

http://www.ttwin.com/support


Appendix C: 

TTWin Lite File Paths
The location of program and configuration files used by TTWin Lite varies depending on the user's operating 
system.  The files used by TTWin Lite can be broken down as follows:

File Category Description

Programs All executables

Global config ttwin.ini and configuration files shared by all users

User config (roaming) User-specific configuration files

User config (non-roaming) User-specific configuration files local to the current computer

Files locations for Windows Vista, Windows 7 and later operating systems are as follows, where {user} is 
replaced with the login users name.

File Category Typical Folder Location

Programs C:\Program Files\Turbosoft\TTWin4 Lite

Global config C:\ProgramData\Turbosoft\TTWin4 Lite

User config (roaming) C:\Users\{User}\AppData\Roaming\Turbosoft\TTWin4 Lite

User config (non-roaming) C:\Users\{User}\AppData\Local\Turbosoft\TTWin4 Lite

File locations for all other operating systems (for example, Windows XP) are as follows, where {user} is 
replaced with the login users name.

File Category Typical Folder Location

Programs C:\Program Files\Turbosoft\TTWin4 Lite

Global config
C:\Documents and Settings\All Users\Application Data\Turbosoft\
TTWin4 Lite

User config (roaming)
C:\Documents and Settings\{User}\Application Data\Turbosoft\
TTWin4 Lite

User config (non-roaming)
C:\Documents and Settings\{User}\Local Settings\Application Data\
Turbosoft\TTWin4 Lite
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